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Workshop Introduction

Workshop Introduction
C2000™ Piccolo™ 1-Day Workshop

Texas Instruments
Technical Training

(310

Baiaen®  C2000 and Piccolo are trademarks of Texas Instruments. Copyright © 2010 Texas Instruments. Al rights reserved.

C2000 Piccolo 1-Day Workshop Outline

¢ Workshop Introduction
¢ Architecture Overview

Programming Development Environment
« Lab: Linker command file

Peripheral Register Header Files

¢ Reset, Interrupts and System Initialization
« Lab: Watchdog and interrupts

¢ Control Peripherals
+ Lab: Generate and graph a PWM waveform

¢ Flash Programming
« Lab: Run the code from flash memory

¢ The Next Step...

L 2

*
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Introductions

Name

Company

Project Responsibilities

DSP / Microcontroller Experience
Tl Processor Experience

Hardware / Software - Assembly / C

Interests

® & 6 6 O o o

Tl Embedded Processing Portfolio

| TI Embedded Processors |

| Microcontrollers (MCUs) | | ARM®-Based Processors | | Digital Signal Processors (DSPs) |
16-bit ultra- 32-bit 32-bit ARM ARM A Ultra
low power real-time Cortex™-M3 Cortex-A8 DSPD+S:RM Muggl:jore Low power
MCUs MCUs MCUs MPUs DSP
( N caoom A Stellaris®\ ( siara™ (" coo00” C6000™ \( C5000™ )
MSP430W Dglfmo ™ ARM® Cortex™-M3 ARMD&C:I;‘GXQMAB vi dlzcua ;/rlort]:ecslso s
Piccolo MAP™ 22,000
Upto 40MHz to Up to 300MHzto  |BooMHzto >1Gh4|  MMACS Up to 300 MHz
25 MHz 300 MHz 100 MHz >1GHz +Accelerator +Accelerator
Flash Flash, RAM Flash Cache, Cache Cache Up to 320KB RAM
1KB to 256 KB 16 KBto 512 KB 8 KB to 256 KB RAM, ROM RAM, ROM RAM,ROM Up to 128KB ROM
Analog 1/0, ADC PWM, ADC, USB,ENET USB, CAN, USB, ENET, SRIO, EMAC USB, ADC
LCD, USB, RF CAN, SPI, IPC “f\AD%"m(Mngi PCle, EMAC PCle, SATA, SPI DMA, PCle McBSP, SPI, 2C
Measurement, Motor Control, | Connectivity, Security| |Industrial computing, | | Foating/Fixed Point (| Telecom T&M, Audio, Voice
Sensing, General || Digital Power, | [Motion Control, HMi,| | POS & portable Video, Audio, Voice, || media gateways, o )
Purpose Lighting, Ren. Enrgyl |\ndustrial Automation data terminals Security, Confer. base stations Medical, Biometrics
$0.25 to $9.00 $1.50 to $20.00 $1.00 to $8.00 $5.00 to $20.00 $5.00 t%o.oo $40 t0 $200.00 $3.00 to $10.00
@ C/ Tw el || e TS
I RSN e LR
Y\ : = TG ¥\ I \

A 7
Bl = _ softwaegDev.Tools _ R N |
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C2000 Portfolio Expanding with
Price/Performance Optimized Derivatives

High-end

High-Precision Control Derivatives

F280x/XX
100 MIPS

Multi-Function,
Appliance &
Consumer Control

Control Performance

F2803x/2x
60 MIPS
Cost

optimized
version

Broad C2000 Application Base

Renewable _T_elecom AC Drives, Industrial i
. Energy Digital Power & Consumer Motor =
Generation Control - @
$ ‘_;3-—-; }
Automotive I =
88 Radar, Electric i 3 lﬂ
8 Power Steering @ g i‘_’ >
& Digital Power e O
L

- /o

1
LED Lighting
E_ 3 @ Consumer,
| Medical & —

o o]
' =4 Non-traditional
] :

Power Line

Communications @:-‘-!’

t
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C2000 Piccolo™ Microcontroller Family
F2802x / F2803x
C
MHz ':)l(alz? Zig CLA gr;alm:;g A(CD;* /F(’m'\;l* é g Communication Ports

F280200 | 40 | 8Kw | 3Kw [ No 1/2 7113 8(0) o|o0 SPI, SCI, 12C
F28020 | 40 | 16Kw | 3Kw [ No 1/2 7113 8(0) 1|0 SPI, SCI, 12C
F28021 | 40 |32Kw | 5Kw [ No 1/2 7113 8 (0) 1|0 SPI, SCI, 12C
F28022 50 | 16Kw | 6Kw No 1/2 7113 8(4) 1(0 SPI, SCI, 12C
F28023 | 50 |32Kw | 6Kw [ No 1/2 7113 8 (4) 1|0 SPI, SCI, 12C
F28026 | 60 | 16Kw | 6Kw [ No 1/2 7113 8 (4) 1|0 SPI, SCI, 12C
F28027 60 | 32Kw | 6Kw No 1/2 7113 8(4) 1(0 SPI, SCI, 12C
F28030 60 | 16Kw | 6Kw No 3 14/16 | 12(0)/14(0) | 1| 1| SPI,SCI,I2CLIN,eCAN
F28031 60 | 32Kw | 8Kw No 3 14/16 | 12(0)/14(0) | 1| 1| SPI,SCI,I2CLIN,eCAN
F28032 | 60 |32Kw | 10Kw [ No 3 14/16 | 12(6)/14(7) | 1| 1| SPI,SCI,I2C,LIN,eCAN
F28033 60 | 32Kw | 10Kw | Yes 3 14/16 | 12(6)/14(7) | 1| 1| SPI,SCLI2C,LIN,eCAN
F28034 | 60 |64Kw | 10Kw [ No 3 14/16 | 12(6)/14(7) | 1| 1| SPI,SCI,I2C,LIN,eCAN
F28035 | 60 |64Kw | 10Kw | Yes 3 14/16 | 12(6)/14(7) | 1| 1| SPI,SCI,I2C,LIN,eCAN
* number dependent on package type: F2802x — 38/48 pins, F2803x — 64/80 pins
« All devices have VREG, POR/BOR, Watchdog, OTP, CPU Timers

For details and information on other C2000 family members refer to the “Embedded Processing Guide” and specific “Data Manuals”

Piccolo™ controlSTICK

LED LD1 LED LD2 TMS320F28027
(Power) (GPI034) 48-Pin Package

=)

. : i< 2
Texas Instruments me:cg'q

USB JTAG On-board USB Peripheral
Interface & Power JTAG Emulation Header Pins

C2000 Piccolo 1-Day Workshop




Architecture Overview

Architecture Overview
TMS320F2802x/3x Block Diagram

Program Bus i 1
|
l l l ; ePWM :
Boot eCAP !
Sectored RAM 1 1

| 1
Flash O BRI == S

1
1
SLABLS 12-bit ADC |«
]

i 1
H — Watchdog |-
l i I k
. PIE b e |
32-bit R-M-W/| ! i | Interrupt — CAN 2.0B i«
32x32 bit ! ' (it
Auxiliary MTt' I'I Atomic| i CLA: MRS i |
ultiplier i ]
Registers| > ALU | i | 'T’“*‘"

1
Emulation 1

CPU

| V= NN k :
]
]

<_T Data Bus |

TMS320F28027 Memory Map

0x000000 1 “C TR :
0x000400 0x3D7C80
ADC/ OSC cal. data
0X000800 1t SARAM (IKW) 0x3D8000 —
0X000D00 5 Ec 0X3F0000
0X000E00---F->-F-6--ék---‘ reserved FLASH (32Kw)
0x002000 - OX3F7FF8 PASSWORDS (8w)
0x006000 0x3F8000 -
PF 1 (4K
0x007000 (4Kw) OX3F9000 L0 SARAM (4Kw)
PF 2 (4Kw) reserved
0x008000 OX3FE000
0X009000 >R RAM () oarercol . 2P (BKw)
Xx3FFF
0x3D7800 User OTP (1Kw) OX3FFFFF BROM Vectors (64w)
0x3D7C00 reserved Data | Program
0x3D7C80
: Dual Mapped: LO

CSM Protected:
LO, OTP
FLASH, ADC CAL,
Flash Regs in PFO
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F28x Fast Interrupt Response Manager

¢ 96 dedicated PIE
vectors
& No software decision

PIE module
For 96
interrupts

=96

28x CPU Interrupt logic

making required @ S
. N INT1 to
& Direct access to RAM . —
. Xectto::ls dat g % ) P 12interrupts M| 1FR || 1IER |[ INTM [ ngﬁ
uto flags update E Register
& Concurrent auto g Map
context save £
Auto Context Save
T STO —
AH AL
PH PL
AR1 (L) | ARO (L)
DP ST1
DBSTAT| IER
PC(msw)| PC(Isw)

C2000 Piccolo 1-Day Workshop 9
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Programming Development Environment

Code Composer Studio

Code Composer Studio: IDE

& C/C++ - Code Composer Studio (Licensed)

File Edit ‘“iew Mavigate Project Target Tools pke window  Help
R AR o G & oebus (B cjoet |
=i
-~ 7| & Integrates: edit, code generation,

s and debug
& {E,Jlnc\udas
Debug . . .
Ly ¢ Single-click access using buttons
L Adcl.c
|5 CodestartBranch. asm . -
e e Powerful graphing/profiling tools
- |5 Delayls, asm
(£ DSP2903,_GlobalariablsDefs.c i i
Aok ¢ Automated tasks using Scripts
i__q Gpio.c
15 Main.c . . .
i ¢ Built-in access to BIOS functions
- ] SysCtrI.‘c

6| Wakchdon.c ¢ Based on the Eclipse open

] DSP2803x_Headers_nonBIOS.cmd

& Labend source software framework

=
=
£
Il
=
=

C/C++ and Debug Perspective (CCSv4)

¢ Each perspective provides a set of functionality
aimed at accomplishing a specific task

¢ C/C++ Perspective ¢ Debug Perspective
+ Displays views used + Displays views used for
during code development debugging
+ C/C++ project, editor, etc. « Menus and toolbars

associated with debugging,
watch and memory
windows, graphs, etc.

10 C2000 Piccolo 1-Day Workshop
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CCSv4 Project

File Edit Wiew Mawvigate Project Target Too
=N el . N
be %8 ®>~ i % i B
5 C/C4++ Projects X S

2 B ¢ List of files:

= 'bc Example [Active - Debug]

Project files contain:

& Binaries + Source (C, assembly)
[E3] d Includes
[+ @ Debug * Libl’al’ieS

[ DSPz803x%_DefaultIsr.h

] Lebh + DSP/BIOS configuration file

Ade.c

B
I B E

ol Rttt + Linker command files

|+J €] Defaullsr.c

[E7] E, DelayUs. asm g o

[ DsP2E0dx_GlobalvarisbleDefs.c L 2 PrOjeCt SettlngS:

[+ |—£| ECap.c . . .

B %EPwm.c « Build options (compiler,
[+ |t Gpio.c A

B[ Marc Linker, assembler, and
] E, PieCtrl.c DSP/B |OS)

[ |:c| PieVect.c X i X

@ 5] Syscrlc + Build configurations

[£] ‘watchdag.c
B DSP2803x%_Headers_nonBIOS.cmd
: }—ﬂ Lab.cmd

¢ File 2 New 2 CCS Project g
3 B Hew CCS Project
Additinal Project Settings c
Defie the rtar-trojct dependences, £ any. f—
= | A—_—
1 5 Hew CCS Praject
L rojects | CpCas Indever
LS Project
Crasts :::u_'max« = Referenced Projects
Broject nama: | Example
] s it hocaticn 7 T s [Ceanmn |
Leation: | CA\C2aLabsEeample [ wowss...
G ot > caenl | 4 9 Hew LS Project f
Project Settings —
Salact the praject sattras. oy,
o
B Hew OS5 Project Oubpud type! [Evocutabie -
2 Select a type of project 5 Frcged seltvngs
: hta deploy on - Device varant: coslectfiters v | ST w! [ mere..
Device Lndarness:
Tl - Code Generstion took: | T1vB.2.6 bl - T
Configurations:
Qb Formak:
] &9
Eoﬁ}m | Lirder Comemearnd Fia: “noe ¥ | Bewsa...
Desehect AR Funkime Support Lbrarys | #3805 T
] Shvew il Profact Types
] 5w ll Configurations
B [ ctmk [ pem s [ o) ¥ [ sk |[ tea> J[ Bmh || cowel |
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CCSv4 Build Options — Compiler / Linker

& Compiler

+ 16 categories for code
generation tools

« Controls many aspects of
the build process, such as:

« Optimization level
« Target device

+ Compiler /assembly /link
options

& Linker

+ 9 categories for linking
+ Specify various link
options
+ ${PROJECT_ROOT}
specifies the current
project directory

Linking Sections in Memory

Sections

Global vars (.ebss)  Init values (.cinit)

&
5

e,
o,

‘.-'.'.’Ji nt )‘2‘.‘-.1 = ;}.2 ; K‘E

int  y/

void main(void)

{

«long z;

Z =X+Y;..

I -,
g .,

%,

",

Local vars (.stack)  Code (.text)

& All code consists of

different parts called
sections

¢ All default section

names begin with “.”

¢ The compiler has

default section
names for initialized
and uninitialized
sections

12
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Programming Development Environment

Compiler Section Names

Initialized Sections

Name Description Link Location

text code FLASH

.cinit initialization values for FLASH
global and static variables

.econst constants (e.g. constint k =3;) FLASH

.switch tables for switch statements FLASH

pinit tables for global constructors (C++) | FLASH

Uninitialized Sections

Name Description Link Location
.ebss global and static variables RAM

.Stack stack space low 64Kw RAM
.esysmem | memory for far malloc functions RAM

Note: During development initialized sections could be linked to RAM since
the emulator can be used to load the RAM

Placing Sections in Memory

Memor .
Y Sections
0x00 0000 MOSARAM
= -
(0x400) - ebss
0x00 0400 M1SARAM
C~ o
(0x400) Te-el
=9 .stack
Ox3F 0000 FLASH e e === .cinit
(0x8000) -
T~ text

C2000 Piccolo 1-Day Workshop
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Programming Development Environment

Linking

e Memory description
e How to place s/w into h/w

Link.cmd

.0bj —| Linker |—— .out

.map

Linker Command File

MEMORY
PAGE O: /* Program Memory */
FLASH: origin = Ox3FO000, length = 0x8000
PAGE 1: /* Data Memory */
MOSARAM: origin = 0x000000, length = 0x400
M1SARAM: origin = 0x000400, length = 0x400
}
SECTIONS
{
.text:> FLASH PAGE = O
.ebss:> MOSARAM PAGE = 1
.cinit:> FLASH PAGE = O
.stack:> M1SARAM PAGE = 1
by

14 C2000 Piccolo 1-Day Workshop



Lab 1: Linker Command File

Lab 1: Linker Command File
» Objective

Use a linker command file to link the C program file (Labl.c) into the system described below.

Lab 1: Linker Command File

Memory 0x00 0000 (MOSARAM
(0x400)
on-chip
memory 0x00 0400 M(loi':‘ng
£28027 0x00 8000 | Lo0SARAM
(0X1000)

System Description:
* TMS320F28027

* All internal RAM
blocks allocated

Placement of Sections:

e .text into RAM Block LOSARAM on PAGE 0 (program memory)
e.cinitinto RAM Block LOSARAM on PAGE 0 (program memory)
.ebss into RAM Block MOSARAM on PAGE 1 (data memory)

e .stack into RAM Block M1SARAM on PAGE 1 (data memory)

System Description
o TMS320F28027

e All internal RAM blocks allocated

Placement of Sections:
e .text into RAM Block LOSARAM on PAGE 0 (program memaory)
e _cinitinto RAM Block LOSARAM on PAGE 0 (program memory)
e .ebss into RAM Block MOSARAM on PAGE 1 (data memory)
e stack into RAM Block M1SARAM on PAGE 1 (data memory)

» Procedure

Start Code Composer Studio and Open a Workspace

1. Start Code Composer Studio (CCS) by double clicking the icon on the desktop or
selecting it from the Windows Start menu. When CCS loads, a dialog box will prompt

you for the location of a workspace folder. Use the default location for the workspace
and click OK.

C2000 Piccolo 1-Day Workshop 15



Lab 1: Linker Command File

This folder contains all CCS custom settings, which includes project settings and views
when CCS is closed so that the same projects and settings will be available when CCS is
opened again. The workspace is saved automatically when CCS is closed.

The first time CCS opens a “Welcome to Code Composer Studio v4” page appears.

Close the page by clicking on the CCS icon in the upper right or by clicking the X on the
“Welcome” tab. You should now have an empty workbench. The term workbench refers
to the desktop development environment. Maximize CCS to fill your screen.

The workbench will open in the “C/C++ Perspective” view. Notice the C/C++ icon in
the upper right-hand corner. A perspective defines the initial layout views of the
workbench windows, toolbars, and menus which are appropriate for a specific type of
task (i.e. code development or debugging). This minimizes clutter to the user interface.
The “C/C++ Perspective” is used to create or build C/C++ projects. A “Debug
Perspective” view will automatically be enabled when the debug session is started. This
perspective is used for debugging C/C++ projects.

Setup Target Configuration

3. Open the emulator target configuration dialog box. On the menu bar click:

Target -> New Target Configuration..

In the file name field type F28027_ctrISTK.ccxml. This is just a descriptive name since
multiple target configuration files can be created. Leave the “Use shared location” box
checked and select Finish.

In the next window that appears, select the emulator using the “Connection” pull-down
list and choose “Texas Instruments XDS100vl USB Emulator”. Inthe box
below, check the box to select “controlSTICK — Piccolo F28027”. Click
Save to save the configuration, then close the “Cheat Sheets” and
“F28027_ctrISTK.ccxml” setup window by clicking the X on the tabs.

To view the target configurations, click:

View - Target Configurations

and click the plus sign (+) to the left of User Defined. Notice that the
F28027_ctrISTK.ccxml file is listed and set as the default. If it is not set as the default,

right-click on the .ccxml file and select “Set as Default”. Close the Target Configurations
window by clicking the X on the tab.

Create a New Project

6. A project contains all the files you will need to develop an executable output file (.out)

which can be run on the MCU hardware. To create a new project click:
File > New - CCS Project

In the Project name field type Labl. Uncheck the “Use default location” box. Click the
Browse... button and navigate to:

16
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Lab 1: Linker Command File

C:\C28x\Labs\Labl\Project
Click OK and then click Next.

7. The next window that appears selects the platform and configurations. Select the
“Project Type” using the pull-down list and choose “C2000”. In the “Configurations”
box below, leave the “Debug” and “Release” boxes checked. This will create folders that
will hold the output files. Click Next.

8. In the next window, inter-project dependencies (if any) are defined. Select Next.

9. Inthe last window, the CCS project settings are selected. Change the “Device Variant”
using the pull-down list to “TMS320F28027”. Next, using the pull-down list change
the “Linker Command File” to “<none>". We will be using our own linker command
file, rather than the one supplied by CCS. The “Runtime Support Library” will be
automatically set to “rts2800_ml . Iib”. This will select the large memory model
runtime support library. Click Finish.

10. A new project has now been created. Notice the C/C++ Projects window contains
Labl. The project is set Active and the output files will be located in the Debug
folder. At this point, the project does not include any source files. The next step is to add
the source files to the project.

11. To add the source files to the project, right-click on Lab1l in the C/C++ Projects
window and select:

Add Files to Project..

or click: Project > Add Files to Active Project..

and make sure you’re looking in C:\C28x\Labs\Lab1\Files. With the “files of
type” set to view all files (*.*) select Labl.c and Labl1.cmd then click OPEN. This
will add the files to the project.

12. Inthe C/C++ Projects window, click the plus sign (+) to the left of Labl and notice
that the files are listed.

Project Build Options

13. There are numerous build options in the project. Most default option settings are
sufficient for getting started. We will inspect a couple of the default options at this time.
Right-click on Lab1l in the C/C++ Projects window and select Properties or
click:

Project - Properties

14. A “Properties” window will open and in the section on the left be sure that “C/C++
Build” category is selected. In the “Configuration Settings” section make sure that the
Tool Settings tab isselected. Next, under “C2000 Linker” select the “Basic
Options”. Notice that .out and .map files are being specified. The .out file is the
executable code that will be loaded into the MCU. The .map file will contain a linker
report showing memory usage and section addresses in memory.

C2000 Piccolo 1-Day Workshop 17



Lab 1: Linker Command File

15.

16.

Next in the “Basic Options” set the Stack Size to 0x200.

Under “C2000 Compiler” select the “Runtime Model Options”. Notice the “Use
large memory model” and “Unified memory” boxes are checked. Select OK to save and
close the Properties window.

Linker Command File — Lab1.cmd

17.

18.

Open and inspect Lab1 . cmd by double clicking on the filename in the project window.
Notice that the Memory{} declaration describes the system memory shown on the
“Labl: Linker Command File” slide in the objective section of this lab exercise.
Memory block LOSARAM has been placed in program memory on page 0, and the other
memory blocks have been placed in data memory on page 1.

In the Sections{} area notice that the sections defined on the slide have been “linked”
into the appropriate memories. Also, notice that a section called .reset has been allocated.
The .reset section is part of the rts2800_ml.lib, and is not needed. By putting the TYPE =
DSECT maodifier after its allocation, the linker will ignore this section and not allocate it.
Close the inspected file.

Build and Load the Project

19.

20.

21.

22.
23.

Three buttons on the horizontal toolbar control code generation. Hover your mouse over
each button as you read the following descriptions:

R R A
Button _Name Description
1 Build Incremental build and link of only modified source files
2 Rebuild Full build and link of all source files
3 Debug Automatically build, link, load and launch debug-session

Click the “Bui 1d” button and watch the tools run in the Console window. Check for
errors in the Prob lems window (we have deliberately put an error in Labl.c). When
you get an error, you will see the error message (in red) in the Problems window, and
simply double-click the error message. The editor will automatically open to the source
file containing the error, and position the mouse cursor at the correct code line.

Fix the error by adding a semicolon at the end of the “z = x + y” statement. For
future knowledge, realize that a single code error can sometimes generate multiple error
messages at build time. This was not the case here.

Build the project again. There should be no errors this time.

CCS can automatically save modified source files, build the program, open the debug
perspective view, connect and download it to the target, and then run the program to the
beginning of the main function.

Click on the “Debug” button (green bug) or click Target -> Debug Active
Project.

18

C2000 Piccolo 1-Day Workshop



Lab 1: Linker Command File

Notice the Debug icon in the upper right-hand corner indicating that we are now in the
“Debug Perspective” view. The program ran through the C-environment initialization
routine in the rts2800_ml.lib and stopped at main() in Labl.c.

Debug Environment Windows

It is standard debug practice to watch local and global variables while debugging code. There
are various methods for doing this in Code Composer Studio. We will examine two of them
here: memory windows, and watch windows.

24. Open a “Memory” window to view the global variable “z”.
Click: View > Memory on the menu bar.

Type &z into the address field and select “Data” memory page. Note that you must use
the ampersand (meaning “address of””) when using a symbol in a memory window
address box. Also note that Code Composer Studio is case sensitive.

Set the properties format to “Hex 16 Bit — Tl Style Hex” in the window. This will give
you more viewable data in the window. You can change the contents of any address in
the memory window by double-clicking on its value. This is useful during debug.

25. Notice the “Local(1)” window automatically opened and the local variables X and y are
present. The local window will always contain the local variables for the code function
currently being executed.

(Note that local variables actually live on the stack. You can also view local variables in
a memory window by setting the address to “SP” after the code function has been
entered).

26. We can also add global variables to the watch window if desired. Let's add the global
variable “z”.

Click the “Watch (1)” tab at the top of the watch window. In the empty box in the
“Name” column, type z and then enter. An ampersand is not used here. The watch
window knows you are specifying a symbol. (Note that the watch window can be
manually opened by clicking: View -> Watch Window on the menu bar).

Check that the watch window and memory window both report the same value for “z”.
Trying changing the value in one window, and notice that the value also changes in the
other window.

Single-stepping the Code

27. Click the “Local (1)” tab at the top of the watch window. Single-step through main()
by using the <F5> key (or you can use the Step Into button on the horizontal
toolbar). Check to see if the program is working as expected. What is the value for “z”
when you get to the end of the program?
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Lab 1: Linker Command File

Terminate Debug Session and Close Project

28. The Terminate Al button will terminate the active debug session, close the
debugger and return CCS to the “C/C++ Perspective” view.

Click: Target - Terminate All oruse the Terminate All icon: & -
Close the Terminate Debug Session “Cheat Sheet” by clicking on the X on the tab.

29. Next, close the project by right-clicking on Lab1l in the C/C++ Projects window
and select Close Project.

End of Exercise
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Peripheral Register Header Files

Peripheral Register Header Files

Traditional Approach to C Coding

#define ADCCTL1 (volatile unsigned int *)0x00007100

void main(void)

{
*ADCCTL1 = 0x1234; //write entire register
*ADCCTL1 |= 0x4000; //enable ADC module
3
Advantages - Simple, fast and easy to type

- Variable names exactly match register names (easy
to remember)

Requires individual masks to be generated to
manipulate individual bits

- Cannot easily display bit fields in debugger window
- Will generate less efficient code in many cases

Disadvantages

Structure Approach to C Coding

void main(void)

{
AdcRegs.ADCCTL1.all = 0x1234; //write entire register
AdcRegs.ADCCTL1.bit.ADCENABLE = 1; //enable ADC module

}

Advantages - Easy to manipulate individual bits

Watch window is amazing! (next slide)
Generates most efficient code (on C28x)

Can be difficult to remember the structure names
(Editor Auto Complete feature to the rescue!)

- More to type (again, Editor Auto Complete feature
to the rescue)

Disadvantages
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Peripheral Register Header Files

Built-in CCSv4 Register Window

Hame: alue
B Core Registers

& anc

it ADCRESULT

S svscTRL

% 5 CPUTIMER

i pevemu

it SYSPWRCTRL

# B ecana

il eCama_LaM

# St eCANA_MOTS

5 ecAMA_MOTO

o m‘. eCAMNA_MBX_CONTENT
B ecapt

= Gt compz
&4 comes

i ePuni
& 5 epwms
& 5 epwis
& 5 epwmr

) (i I
(i HT
® fi GPIO
& 5 120

# &
o
240
=

@ aoceria

@ apceriz

[ aocTFLe

[} ADCINTFLGOLR
[ aocvTovE

[ ADCINTOVRCLR.
O uTsELINg

) uTsELaNg

() uTsELSNS

) msELTNE

3 INTSELOMID

[ socPRICTL

[ ADCSAMPLEMODE
(@ ADCINTSOCSELL
(@ ADCINTSOCSEL?
3 AncsocrLGr

I3 AocsocFRCL

3 AncsocovF

(@ AbcsocovrcLri

@ aocsocacTL
3 apcsocscTL
[} ADCsocscTL
() ApcsocscTL
@ ApcsocrcTL
[ ApcsocecTL
[ ApcsocscTL
3 apcsocineTL

3 ancsociacTL

0x40E4
0x0000
0x000L
0x0000
0x000L
0x0000
0x0080
0x0000
0x0000
0x0000
0x0000
0x0000
0x0000
0x0000
0x0000
0x0000
0x0000
0x0000
0x0000
0x3806
0x0000
0x0000
0x0000
0x0000
0x0000
0x0000
0x0000
0x0000
0x0000
0x0000
0x0000
0x0000
0x0000
0x0000

g

)

o

(2 ApccTLL

= all Ox40E4
L] Lok
(=)= TEMPCONY 0

[
[
[
&
-
[
&
[
[
[

0x00007 101@Data

F

0x00007100@Data

SOCPRICTL {ok
rsvd3 )
¥ (2 ADCSAMPLEMODE {0}
B= revdd i}
[ (# ADCINTSOCSELY {3
[ (® ADCINTSOCSEL2 {wk
® (# rsvs 0xD0007116@Data
[ (2 ADCSOCFLGL
60- rswds 0
# [(# ADCSOCFRCL {k

000007 100@Data
0x00007100@0ata
0x00007100@0ata
0x00007100@0ata
0x00007100@0ata
000007 100@Data
0x00007100@Data
000007100@0ata
0:00007100@0ata
000007 100@Data
0x00007100@Data
0x00007100@0ata
0x00007100@0ata
0x00007100@0ata
0x00007100@0ata
0x00007101@Data
0:00007104@Data
0:0000710S@0ata
000007106 @0ata
000007 107@Data
0x00007103@Data
0x00007109@0ata
0x0000710A@Data
0x0000710B@0ata
0x0000710C@0ata
0300007 10D@D3ta
0:00007110@0ata
00000711 1@0ata
0x00007112@0ata
0x00007113@Data
0x00007114@Data
0x00007115@0ata
0x00007116@0ata
0x00007118@0ata
0x00007119@Data
0200007 11A@Data

union ADCCTLL_REG
unsigned int

struct ADCCTLL_BITS
(unsigred int:15: 1)
{unsigred int:14: 1)
(unsigred int:13:1)
{unsigried int
{unsigned int:
{unsigned int:
{unsigred int:5:1)

{unsigred int:5:1)

(unsigned int:3:5)

(unsigred int:2:1)

(unsigred int;1:1)

{unsigred int;0:1)

unsigned int[3]

union ADCINT_REG

union ADCINT_REG

union ADCINT_REG

union ADCINT_REG

union INTSELINZ_REG

union INTSELEN4_REG

union INTSELSNG_REG

union INTSELNG_REG

union INTSELSM10_REG
unsigried int[3]

union SOCPRICTL_REG
unsigned int

union ADCSAMPLEMODE_REG
unsigned int

union ADCINTSOCSELL_REG
union ADCINTSOCSELZ_REG
unsigned int[2]

union ADCSOC_REG
unsigned int

union ADCSOC_REG

Format
Hatur:
Matural

Hexadecimal
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
Matural
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Peripheral Register Header Files

Structure Naming Conventions

¢ The DSP2802x header files define:
+ All of the peripheral structures
+ All of the register names
+ All of the bit field names
+ All of the register addresses

PeripheralName.RegisterName.all /I Access full 16 or 32-bit register
PeripheralName.RegisterName.half.L SW /I Access low 16-bits of 32-bit register
PeripheralName.RegisterName.half. MSW /I Access high 16-bits of 32-bit register

PeripheralName.RegisterName.bit.FieldName // Access specified bit fields of register

Notes: [1] “PeripheralName” are assigned by Tl and found in the DSP2802x header files.
They are a combination of capital and small letters (i.e. CpuTimerORegs).

[2] “ RegisterName” are the same names as used in the data sheet.
They are always in capital letters (i.e. TCR, TIM, TPR,..).

[3] “FieldName” are the same names as used in the data sheet.
They are always in capital letters (i.e. POL, TOG, TSS,..).

Editor Auto Complete to the Rescue!

BB CIC v - Ade.c - Code Composer Studio (Licensed)
e Lok Wew Naogets Froject Jooks Target Sinpts Window Help

H & B8 e G- i ¥ bl Bl * [ Brebun | Qo

B tader X =2

-

AdcRegs . ADCCTLL.BAE . HES)

AdcRegs. ADCCTLL, D1t HESET = 1

AdcRegs.ADCCTL1.all = OxO00E4:

DelayUs= (1000} ; Vait 1 ms after pover-up before using the ADC

C0 monfiguracisr
AdcRegs, ADCSANPLENODE.iv, SINULEND = O: FCC0 in sing

AdeRegn. ADCSOCOCTL . bit, TRIGIEL = 72
AdcRegs. ADCIOCOCTL.bit  CHSEL = Os
AdcRegs. APCIOCOCTL.biL  ACOPS = 6:

\wirktable Seart nseet | 20
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Peripheral Register Header Files

DSP2802x Header File Package

(http://lwww.ti.com, literature # SPRC832)

¢ Contains everything needed to use the
structure approach

¢ Defines all peripheral register bits and
register addresses

¢ Header file package includes:

+ \DSP2802x _headers\include = .h files
+ \DSP2802x headers\cmd - linker .cmd files

+ \DSP2802x_headers\gel - .gel files for CCS
+ \DSP2802x_examples - CCS3 examples
+ \DSP2802x_examples_ccsv4 > CCS4 examples
+ \doc - documentation

Peripheral Structure .h files o2

¢ Contain bits field structure definitions for each peripheral register
DSP2802x_Adc.h

/I ADC Individual Register Bit Definitions:

struct ADCCTL1_BITS { /I bits description
Uint16 TEMPCONV:1; /10 Temperature sensor connection
Uintl6 VREFLOCONV:1; // 1VSSA connection

Your C-source file (e_g_, Ad C.C) Uint16 INTPULSEPOS:1; // 2 INT pulse generation control
- - Uintl6 ADCREFSEL:1; // 3Internal/external reference select
#include "DSP2802x_Deviceh" X
- Uint16 rsvdil:1; /I 4reserved

Uintl6 ADCREFPWD:1; // 5 Reference buffers powerdown
Uint16 ADCBGPWD:1; /6 ADC bandgap powerdown

{ Uintl6 ADCPWDN:1; /I'7 ADC powerdown
¥ Reset the ADC module */ X
i Uint16 ADCBSYCHN:5; //12:8 ADC busy on a channel
AdcRegs.ADCCTL1.bit.RESET = 1;

Void InitAdc(void)

Uint16 ADCBSY:1; /113 ADC busy signal
i confiaure the ADC recister 1 Uint16 ADCENABLE:L,  //14 ADC enable
SCITS (D AP (R Uint16 RESET:1; I/ 15 ADC master reset

AdcRegs.ADCCTL1.all = 0x00E4;

¥ b

/I Allow access to the bit fields or entire register:
union ADCCTL1 REG {

Uint16 all;

struct ADCCTL1 BITS bit;
h
/I ADC External References & Function Declarations:
extern volatile struct ADC_REGS AdcRegs;
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Peripheral Register Header Files

Peripheral Structure .h files o2

¢ The header file package contains a .h file
for each peripheral in the device

DSP2802x_Adc.h DSP2802x_BootVars.h DSP2802x_Comp.h
DSP2802x_CpuTimers.h DSP2802x_DevEmu.h DSP2802x_Device.h
DSP2802x_ECap.h DSP2802x_EPwm.h DSP2802x_Gpio.h
DSP2802x_l2c.h DSP2802x_Nmilntrupt.h DSP2802x_PieCtrl.h
DSP2802x_PieVect.h DSP2802x_Sci.h DSP2802x_Spi.h
DSP2802x_SysCtrl.h DSP2802x_Xlintrupt.h

¢ DSP2802x_Device.h
+« Main include file
+« Will include all other .h files

+ Include this file (directly or indirectly)
in each source file:

#include “DSP2802x_Device.h”

Global Variable Definitions File
DSP2802x_GlobalVariableDefs.c

¢ Declares a global instantiation of the structure
for each peripheral

¢ Each structure is placed in its own section
using a DATA_SECTION pragma to allow
linking to the correct memory (see next slide)

DSP2802x_GlobalVariableDefs.c
#include "DSP2802x_Device.h"

#pragma DATA_SECTION(AdcRegs,"AdcRegsFile");
volatile struct ADC_REGS AdcRegs;

¢ Add this file to your CCS project:
DSP2802x_GlobalVariableDefs.c
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Peripheral Register Header Files

Linker Command Files for the Structures
DSP2802x_nonBIOS.cmd

DSP2802x_GlobalVariableDefs.c

#include "DSP2802x_Device.h"

—#pragma DATA_SECTION(AdcRegs,"AdcRegsFile");
volatile struct ADC_REGS AdcRegs;

DSP2802x_Headers_nonBIOS.cmd

MEMORY
PAGEL:
ADC:  origin=0x007100, length=0x000080

3
SECTIONS
{

AdcRegsFile: > ADC PAGE = 1

}

& Links each structure to
the address of the
peripheral using the
structures named
section

& Add this file to your
CCS project:

DSP2802x_nonBIOS.cmd

Peripheral Specific Examples

¢ Example projects for each peripheral
¢ Helpful to get you started

|Jadc_soc | eprwm_updown_ag
|J)adc_temp_sensor |[Z) external_interrupk
|Jcpu_timer |ZIflash
|[Ciecap_apwm | gpio_setup
|[ZJecap_capture_pwm I gpin_toogle
|Z)eprnn_blanking_window |2 hirparn
|ZJepwm_dcevent_trip | hrpern_duty_sfo_ve
[Chepwm_dcevent_trip_comp ) brpwin_prdup_sfo_veé
|Ziepwm_deadband | hrpemn_prdupdown_sfa_vd [ timed_led_blink
|ZJepwn_timer_interrupks |0 brpramn_slider
|Jeprnn_trip_zone |J)iZe_eeprom
|[Jepwm_up_ag I lpm_haltwake

[ lprn_idlewake

|2 lpm_standbywake
|Z)sci_echoback

| scia_loophack.
|Z)scia_loopback_interrupts
| spi_loopback.

| ) spi_loopback_interrupts
|[Z)sw_prioritized_interrupts

|Z)watchdog

26
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Peripheral Register Header Files

Peripheral Register Header Files

Go to http:/Mwww.ti.com and enter the literature number in the keyword search box

Summary
¢ Easier code development
¢ Easytouse
¢ Generates most efficient code
¢ Increases effectiveness of CCS watch window
¢ Tl has already done all the work!
+ Use the correct header file package for your device:

+« F2802x # SPRC832

+ F2803x # SPRC892

+ F2833x and F2823x # SPRC530

+ F280x and F2801x # SPRC191

+ F2804x # SPRC324

. F281x # SPRC097

C2000 Piccolo 1-Day Workshop
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Reset, Interrupts and System Initialization

Reset, Interrupts and System Initialization

Reset

Reset Sources

Missing Clock Detect F28x core

Watchdog Timer
Power-on Reset
Brown-out Reset

XRS pin active

XRS

To XRS pin

Logic shown is functional representation, not actualimplementation

. POR — Power-on Reset generates a device reset during
power-up conditions

* BOR — Brown-out Reset generates a device reset if the
power supply drops below specification for the device

Note: Devices support an on-chip voltage regulator (VREG) to
generate the core voltage

Reset — Bootloader

ReS et Reset vector
OBJMODE =0 febtched from Bootloader sets
= oot ROM OBJMODE =1
"ENPiE 0. 0X3F FFCO AMODE =9
INTM=1
YES Emulator NO

TRST=1| Connected? |TrRsT=0

Emulation Boot Stand-alone Boot
Boot determined by Boot determined by
2 RAM locations: 2 GPIO pins and

EMU_KEY and EMU_BMODE 2 OTP locations:
OTP_KEY and OTP_BMODE

_ EMU_KEY & EMU_BMODE located in PIE at 0xOD0O & 0x0DO01, respectively
TRST =JTAG Test Reset  GTpKEy & OTP BMODE located in OTP at Ox3D78FE & OX3D78FF respectively
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Reset, Interrupts and System Initialization

Emulation Boot Mode (TrsT=1)

Emulator Connected
Emulation Boot
Boot determined by

2 RAM locations:
EMU_KEY and EMU_BMODE

Boot Mode

EMU_KEY = 0x55AA ? |

Wait

YES
EMU_BMODE = | Boot Mode
0x0000 Parallel 1/10
0x0001 SCI
0x0003 GetMode
0x0004 SPI
0x0005 12C
0x0006 OoTP
0x000A MO SARAM
0x000B FLASH
other Wait

If either EMU_KEY or EMU_BMODE
are invalid, the “wait” boot mode is
used. These values can then be
modified using the debugger and a
reset issued to restart the boot process

—>| OTP_KEY =0x55AA ? |

1 NO |Boot Mode

FLASH
l YES
OTP_BMODE = | Boot Mode
0x0001 SCI
0x0004 SPI
0x0005 12C
0x0006 OTP
other FLASH

Stand-Alone Boot Mode (TrsT=0)

Emulator Not Connected
Stand-alone Boot
Boot determined by
2 GPIO pins and

2 OTP locations:
OTP_KEY and OTP_BMODE

GPIO GPIO
37 34 |Boot Mode
0 0 |[Parallel /O
0 1 SCI
1 0 [Wait
1 1 | GetMode

Note that the boot behavior for
unprogrammed OTP is the
“FLASH’" boot mode

—| OTP_KEY = Ox55AA ? |

1 NO [Boot Mode

FLASH
l YES
OTP_BMODE = | Boot Mode
0x0001 SCI
0x0004 SPI
0x0005 12C
0x0006 oTP
other FLASH

C2000 Piccolo 1-Day Workshop
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Reset, Interrupts and System Initialization

Reset Code Flow - Summary
0x000000 0x000000
MO SARAM (1Kw)
0x3D7800 0x3D7800
OTP (1Kw)
0X3F0000[
| FLASH (32Kw)
O0x3F7FF6
OX3FEO00[™ B0t ROM (8KW) Execution Entry
determined by -
Boot Code Emulation Boot Mode or 1
Ox3FF7BB Stand-Alone Boot Mode :
i ¥ |
BROM vector (64w) i
RESET HE OX3FFFCO 0x3FF7BB Bootloading
_______________________ Routines
(SCI, SPI, 12C,
"""""""""""" Parallel 1/0)
Interrupts
Interrupt Sources
Internal Sources
TINT2
TINTL F28x CORE
TINTO XRS
NMI
ePWM, eCAP, PIE INTL
ADC, SCI, SPI, (Peripheral
12C, WD Interrupt INT2
Expansion)

External Sources

"

__________ . INT12
| INT13
XINT1 = XINT3 ——
—_ INT14
TZx |
XR :
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Reset, Interrupts and System Initialization

Maskable Interrupt Processing

Conceptual Core Overview

Core (IFR) (IER) (INTM)
Interrupt  “Latch” “Switch” “Global Switch”
ﬁ. ‘Iil « .
T2 ——{o]———"" C28x
. . . e Core
INT14 [1] .

¢ Avalid signal on a specific interrupt line causes the latch
to display a“1” in the appropriate bit

¢ If theindividual and global switches are turned “on” the
interrupt reaches the core

Core Interrupt Registers

Interrupt Flag Register (IFR) (pending = 1/ absent = 0)
15 14 13 9 8

12 11 10
RTOSINT [ DLOGINT | INT14 INT13 INT12 INT11 INT10 INT9
INT8 INT7 INT6 INTS INT4 INT3 INT2 INTL
7 6 5 4 3 2 1 0
Interrupt Enable Register (IER) (enable = 1/ disable =0)
15 14 13 12 11 10 9 8
RTOSINT [ DLOGINT | INT14 INT13 INT12 INT11 INT10 INT9
INT8 INT7 INT6 INTS INT4 INT3 INT2 INT1
7 6 5 4 3 2 1 0
Interrupt Global Mask Bit (INTM) Bit 0
ST1 INTM | (enable = 0/ disable = 1)

/¥* Interrupt Enable Register ***/
extern cregister volatile unsigned int IER;

IER |= 0X0008;
IER &= OXFFF7;

[** Global Interrupts ***/
asm(“ CLRC INTM");
asm(“ SETC INTM”);

/lenable INT4 in IER
/ldisable INT4 in IER

/lenable global interrupts
/[disable global interrupts

C2000 Piccolo 1-Day Workshop
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Reset, Interrupts and System Initialization

Peripheral Interrupt Expansion (PIE)

Peripheral Interrupt Expansion - PIE

Interrupt Group 1

PIE module for 96 Interrupts

@ = PIEIFR1 PIEIER1
o INT1.x interrupt grou
? ! B INTL.L—[T}——" 1
INT2.x interrupt group Y%
- INT1.2—>| :|_ .
INT3.x interrupt group NTI
INT4.x interrupt group . .
INT5.x interrupt group INTL.8—[T] ]
INT6.x interrupt group

INT7 .x interrupt group

8l

28x Core Interrupt logic

INT8.x interrupt group

INT9.x interrupt group INT1-INT12
INT10.x interrupt group | [ 15 nterruptsyH & H & E 28x
=1 [=| |Z] |Core

Peripheral Interrupts 12x8

INT11.x interrupt group

INT12.x interrupt group

INT13 (TINT1)

INT14 (TINT2)

NMI

F2802x PIE Interrupt Assignment Table

INTX.8 INTX.7 INTX.6 INTX.5 INTX.4 INTX.3 INTX.2 INTx.1

INTL |waKeNT| TINTO | ADcINTO| xiNT2 | XINT1 ADCINT2 | ADCINT1

INT2 EPWM4 | EPWM3 | EPWM2 | EPWMIL

TZINT | _TzINT | _TzINT | _TzINT

N EPWM4 | EPWM3 | EPWM2 | EPWML

CINT CINT CINT CINT

ECAPL

INT4 o
INT5

SPITX | SPIRX

INT6 INTA INTA
INT7

INTS 12CINT2A | 12CINT1A

SCITX | SCRRX

INT9 INTA INTA

INT10 | ADCINTS | ADCINT7 | ADCINT6 | ADCINT5 | ADCINT4 | ADCINT3 | ADCINT2 | ADCINTL
INT11

INT12 XINT3
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Reset, Interrupts and System Initialization

PIE Registers

15-8 7 6

PIEIFRx register (x =1to 12)
15-8 7 6 5 4 3 2 1 0
reserved INTX.8| INTX.7| INTX.6| INTX.5[ INTX.4| INTX.3| INTx.2 | INTx.1
PIEIERX register (x =1to12)

5 4 3 2 1 0

reserved | INTX.8| INTX.7| INTX.6| INTX.5| INTX.4| INTX.3| INTX.2| INTX.1|

PIE Interrupt Acknowledge R
15-12 11 10 9 8

egister (PIEACK)
7 6 5

4

reserved

PIEACKXx

PIECTRL register

15-1

PIEVECT

ENPIE

#include “DSP2802x_Device.h”
PieCtrlIRegs.PIEIFR1.bit.INTx4 = 1;
PieCtrIRegs.PIEIER3.bit.INTx2 = 1;
PieCtrIRegs.PIEACK.all = 0x0004;
PieCtrIRegs.PIECTRL.bit.ENPIE =

/Imanually set IFR for XINT1 in PIE group 1
/lenable EPWM2_INT in PIE group 3
/lacknowledge the PIE group 3

1; /lenable the PIE

Vector Offset
RESET 00
INT1 02
INT2 04
INT3 06
INT4 08
INT5 0A
INT6 (003
INT7 OE
INT8 10
INT9 12
INT10 14
INT11 16
INT12 18
INT13 1A
INT14 1C
DATALOG 1E
RTOSINT 20
EMUINT 22
NMI 24
ILLEGAL 26
USER 1-12 | 28-3E

Default Interrupt Vector Table at Reset

Default Vector Table
Re-mapped when
ENPIE=1

Memory

PIE Vectors
256w

BROM Vectors
64w

ENPIE =0

PieVectTablelnit{ }
Used to initialize PIE vectors
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Reset, Interrupts and System Initialization

Oscillator / PLL Clock Module

F2802x Oscillator / PLL Clock Module
(lab file: SysCitrl.c)
WDCLK§RCSEL
Internal ‘
gg(r:nl OSCICLK 0*| WDCLK | Watchdog
(10 MHz) 1 Module
OSCCLKSRCSEL
OSCCLKSBCZ !
Internal | 0SC2CLK l\l —»Bﬁ _ OSCCLK DIVSEL
Y - 1 (PLL bypass) i
(10 MH2) 0* ) P x 7 CLKIN
2 (Un C28x
VCOCLK Core
PLL e
XCLKINOFF -__________________i SYSCLKOUT
! ! s
XCLKIN (Y
L+10 LSPCLK
2 11 | cPUTMR2CLK scl, spl
; 01 All other peripherals
> SYSCLKOUT—{00% R clocked by SYSCLKOUT
* = default

F2802x PLL and LOSPCP

(lab file: SysCitrl.c)

OSCCLK SysCtrlF:eegs.PL LSTS.bit.DIVSEL

PLL bypass )
( ypass) X CLKIN | C28x SYSCLKOUT

=i ElL Core LSPCLK
VCOCLK LOSPCP
PLL Ve !

1 1
i H SysCtrlIRegs.LOSPCP.bit.LSPCLK

SysCtrlIRegs.PLLCR.bit.DIV

LSPCLK | Peripheral Clk Freq

DIV CLKIN DIVSEL | n 000 | SYSCLKOUT /1
0000 | OSCCLK /n*(PLL bypass) 0x 14 * g (1’ (1) gggtﬁgﬂ ji .
0001 | OSCCLKx1/n 10 2 011 | syscikouT /6
0010 | OSCCLKx2/n 11 n

0011 OSCCLK x 3/n 100 SYSCLKOUT /8

* default 101 | SYSCLKOUT/10
0100 | o3k XA Note /L mode can | 110 | SYSCLKOUT/12
0110 | OSCCLK x6/n PLL is bypassed 204 || SECReYriie

0111 OSCCLK x 7 /n
1000 OSCCLK x 8/n
1001 OSCCLK x9/n

Input Clock Fail Detect Circuitry

1010 OSCCLK x 10/ n PLL will issue a “limp mode” clock (1-4 MHz) if input
1011 OSCCLK x 11/n clock is removed after PLL has locked.
1100 OSCCLK x 12/ n An internal device reset will also be issued (XRSn

pin not driven).
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Reset, Interrupts and System Initialization

Watchdog Timer Module

Watchdog Timer

¢ Resets the C28x if the CPU crashes
+ Watchdog counter runs independent of CPU

+ If counter overflows, a reset or interrupt is
triggered (user selectable)

+ CPU must write correct data key sequence to
reset the counter before overflow

¢ Watchdog must be serviced or disabled
within 131,072 WDCLK cycles after reset

¢ This translates to 13.11 ms with a 10 MHz
WDCLK

Watchdog Timer Module
(lab file: Watchdog.c)
WDPS WDOVERRIDE
Watchdog A
WDCLK /512
- Prescaler WDDIS
8-bit Watchdog
Counter
CLR
System out tﬂRS»T
Reset P%Igg —
WDCHK WDINT
55+ AA
Detector| cood Key l-l-l 3
t [TT 4 Bad WDCHK Key
Watchdog E
Reset Key
Register
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GPIO

F2802x GPIO Grouping Overview

(lab file: Gpio.c)

GPIO Port A Mux1 Input o
«— R éﬁggfﬂ%’ XD = GpoPortA e — D
Direction Register Qual o
GPADIR% o[>
GPIO Port A Mux2 [GPIO O to 31] _ %
b Register (GPAMUX2) |¢=—p N
GPIO 16 to 31]
2 GPIO Port B < g < %
o) GPIO Port B Mux1 Mt Al I ual | |3
S Register (GPBMUX1) Direction Register Q o
= GPIO 32 to 38 (CPEDI S
@ | [GPIO 32 to 38] > S
& @
2
ANALOG Port  |e >
ANALOG /O Mux1 ; ; :
+— Register (NOMUXT) ¢ D'fect;\?gg,gi'stef o—
[AIO 0 to 15] [Aﬂo e 35, |0
o
F2802x GPIO Pin Block Diagram
(lab file: Gpio.c)
. Peripheral Peripheral Peripheral
GPxSET 0 =Input
GGPX%LCI-}E(?R 1 =Output
PXT! LE
GPxDIR \ /
(GPxDAT] o1 10
C N o o] GPXMUXL
/0 DAT | 00 11 ERAThe
Bit (RW) | |n MUX Control Bits *
‘ 00=GPIO
01 = Peripheral 1
10 = Peripheral 2
11 = Peripheral 3
Input
Qualification
GPXPUD s sonmss (GPIO 0-38) GPxQSEL1
Int | PUll-U GPxQSEL2
nternal Pull-Up GPxCTRL
0 =enable (default GPIO 12-38)
1 =disable (default GPIO 0-11)
Pin

* See device datasheet for pin function selection matrices
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Reset, Interrupts and System Initialization

F2802x GPIO Input Qualification

ines

Input to GPIO and
pin O S peripheral
Qualification modules
1

SYSCLKOUT

¢ Qualification available on ports A & B (GPIO 0 - 38) only
¢ Individually selectable per pin ks
» no qualification (peripherals only) l l l
+ sync to SYSCLKOUT only
+ qualify 3 samples < JW
« qualify 6 samples i > | |
¢ AIO pins are fixed as _ r T 7T
sync to SYSCLKOUT S g

Lab 2: System Initialization

¢ LAB2 files have been provided
¢ LAB2 consists of two parts:

Part 1

+ Test behavior of watchdog when disabled and enabled

Part 2

« Initialize peripheral interrupt expansion (PIE) vectors
and use watchdog to generate an interrupt

¢ Modify, build, and test code using Code

Composer Studio

C2000 Piccolo 1-Day Workshop
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Lab 2: System Initialization

Lab 2: System Initialization
» Objective

The objective of this lab is to perform the processor system initialization. Additionally, the
peripheral interrupt expansion (PIE) vectors will be initialized and tested. The system
initialization for this lab will consist of the following:

e Setup the clock module — PLL, LOSPCP = /4, low-power modes to default values, enable
all module clocks

e Disable the watchdog — clear WD flag, disable watchdog, WD prescale = 1

e Setup watchdog system control register —- DO NOT clear WD OVERRIDE bit, WD
generate a CPU reset

e Setup shared /O pins — set all GPIO pins to GPIO function (e.g. a "00" setting for GPIO
function, and a “01”, “10”, or “11” setting for peripheral function.)

The first part of the lab exercise will setup the system initialization and test the watchdog
operation by having the watchdog cause a reset. In the second part of the lab exercise the PIE
vectors will be tested by using the watchdog to generate an interrupt. This lab will make use of
the DSP2802x C-code header files to simplify the programming of the device, as well as take care
of the register definitions and addresses. Please review these files, and make use of them in the
future, as needed.

» Procedure

Open the Project

1. A project named Lab2 has been created for this lab. Open the project by clicking on
Project - Import Existing CCS/CCE Eclipse Project. The “Import”
window will open then click Browse... next to the “Select root directory” box. Navigate
to: C:\C28x\Labs\Lab2\Project and click OK. Then click Finish to import the
project.

2. Inthe C/C++ Projects window, click the plus sign (+) to the left of Lab2 to view
the project files. All Build Options have been configured for this lab. The files used in

this lab are:
CodeStartBranch.asm Lab 2 3.cmd
Defaultlsr_2.c Main_2.c
DelayUs.asm PieCtrl.c
DSP2802x_GlobalVvariableDefs.c PieVect.c
DSP2802x_Headers nonBI0S.cmd SysCtrl.c
Gpio.c Watchdog.c
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Lab 2: System Initialization

Modified Memory Configuration

3. Open and inspect the linker command file Lab_2_ 3.cmd. Notice that the user defined
section ““codestart’ is being linked to a memory block named BEGIN_MO. The
codestart section contains code that branches to the code entry point of the project. The
bootloader must branch to the codestart section at the end of the boot process. Recall that
the emulation boot mode "M0 SARAM" branches to address 0x000000 upon bootloader
completion.

The linker command file (Lab_2_3.cmd) has a new memory block named BEGIN_MO:
origin = 0x000000, length = 0x0002, in program memory. Additionally, the existing
memory block MOSARAM in data memory has been modified to avoid overlaps with this
new memory block.

System Initialization

4. Open and inspect SysCtrl .c. Notice that the PLL and module clocks have been
enabled.

5. Open and inspect Watchdog.c. Notice that the watchdog control register (WDCR) is
configured to disable the watchdog, and the system control and status register (SCSR) is
configured to generate a reset.

6. Open and inspect Gpio.c. Notice that the shared 1/0O pins have been set to the GPIO
function, except for GPIO0 which will be used in the next lab exercise. Close the
inspected files.

Build and Load

7. Click the “Bui 1d” button and watch the tools run in the Console window. Check for
errors in the Problems window.

8. Click the “Debug” button (green bug). The “Debug Perspective” view should open, the
program will load automatically, and you should now be at the start of main().

9. After CCS loaded the program in the previous step, it set the program counter (PC) to
pointto _c_int0O0. It then ran through the C-environment initialization routine in the
rts2800_ml . lib and stopped at the start of main(). CCS did not do a device reset,
and as a result the bootloader was bypassed.

In the remaining parts of this lab exercise, the device will be undergoing a reset due to the
watchdog timer. Therefore, we must configure the device by loading values into
EMU_KEY and EMU BMODE so the bootloader will jump to “M0 SARAM” at address
0x000000. Set the bootloader mode using the menu bar by clicking:

Scripts > EMU Boot Mode Select -> EMU_BOOT_SARAM

If the device is power cycled between lab exercises, or within a lab exercise, be sure to
re-configure the boot mode to EMU_BOOT_SARAM.
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Run the Code — Watchdog Reset

10.

11.

12.

13.

14.

15.

16.

Place the cursor in the “main loop” section (on the asm(*“ NOP’”) ; instruction line)
and right click the mouse key and select Run To Line. This is the same as setting a
breakpoint on the selected line, running to that breakpoint, and then removing the
breakpoint.

Place the cursor on the first line of code in main() and set a breakpoint by right clicking
the mouse key and select Toggle Breakpoint. Notice that line is highlighted with a
blue dot indicating that the breakpoint has been set. Alternately, you can double-click in
the line number field to the left of the code line to set the breakpoint. The breakpoint is
set to prove that the watchdog is disabled. If the watchdog causes a reset, code execution
will stop at this breakpoint.

Run your code for a few seconds by using the Run button on the toolbar, or using
Target -> Run onthe menu bar. After a few seconds halt your code by using the
Hal t button on the toolbar, or by using Target - Halt. Where did your code stop?
Avre the results as expected? If things went as expected, your code should be in the
“main loop”.

Switch to the “C/C++ Perspective” view by clicking the C/C++ icon in the upper right-
hand corner. Modify the InitWatchdog() function to enable the watchdog (WDCR).
In Watchdog . c change the WDCR register value to 0OXO0A8. This will enable the
watchdog to function and cause a reset. Save the file.

Click the “Bui 1d” button. Select Yes to “Reload the program automatically”. Switch
back to the “Debug Perspective” view by clicking the Debug icon in the upper right-
hand corner.

Like before, place the cursor in the “main loop” section (on the asm(** NOP’*) ;
instruction line) and right click the mouse key and select Run To Line.

Run your code. Where did your code stop? Are the results as expected? If things went
as expected, your code should have stopped at the breakpoint. What happened is as
follows. While the code was running, the watchdog timed out and reset the processor.
The reset vector was then fetched and the ROM bootloader began execution. Since the
device is in emulation boot mode (i.e. the emulator is connected) the bootloader read the
EMU_KEY and EMU_BMODE values from the PIE RAM. These values were
previously set for boot to MO SARAM bootmode by CCS. Since these values did not
change and are not affected by reset, the bootloader transferred execution to the
beginning of our code at address 0x000000 in the MOSARAM, and execution continued
until the breakpoint was hit in main( ).

Setup PIE Vector for Watchdog Interrupt

The first part of this lab exercise used the watchdog to generate a CPU reset. This was tested
using a breakpoint set at the beginning of main(). Next, we are going to use the watchdog
to generate an interrupt. This part will demonstrate the interrupt concepts learned in this
module.

40
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Lab 2: System Initialization

17.

18.

19.

20.

21.

22.

23.

Switch to the “C/C++ Perspective” view by clicking the C/C++ icon in the upper right-
hand corner. Notice that the following files are included in the project:
Defaultlsr_2.c

PieCtrl.c
PieVect.c

In Main_2.c, uncomment the code used to call the InitPieCtr1() function. There
are no passed parameters or return values, so the call code is simply:

InitPieCtri(Q);

Using the “PIE Interrupt Assignment Table” shown in the slides find the location for the
watchdog interrupt, “WAKEINT”. This is used in the next step.

PIE group #: # within group:

In main() notice the code used to enable global interrupts (INTM bit), and in
InitWatchdog() the code used to enable the “WAKEINT” interrupt in the PIE
(using the PieCtrIRegs structure) and to enable core INT1 (IER register).

Modify the system control and status register (SCSR) to cause the watchdog to generate
a WAKEINT rather than a reset. In Watchdog - c change the SCSR register value to
0x0002. Save the modified files.

Open and inspect Defaultlsr_2.c. This file contains interrupt service routines. The
ISR for WAKEINT has been trapped by an emulation breakpoint contained in an inline
assembly statement using “ESTOPOQ”. This gives the same results as placing a breakpoint
in the ISR. We will run the lab exercise as before, except this time the watchdog will
generate an interrupt. If the registers have been configured properly, the code will be
trapped in the ISR.

Open and inspect PieCtrl.c. This file is used to initialize the PIE RAM and enable
the PIE. The interrupt vector table located in PieVect.c is copied to the PIE RAM to
setup the vectors for the interrupts. Close the modified and inspected files.

Build and Load

24,

Click the “Bui 1d” button and select Yes to “Reload the program automatically”.
Switch to the “Debug Perspective” view by clicking the Debug icon in the upper right-
hand corner.

Run the Code — Watchdog Interrupt

25.

26.

Place the cursor in the “main loop” section, right click the mouse key and select Run
To Line.

Run your code. Where did your code stop? Are the results as expected? If things went
as expected, your code should stop at the “ESTOPO0” instruction in the WAKEINT ISR.
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Terminate Debug Session and Close Project

27. Terminate the active debug session using the Terminate Al button. This will close
the debugger and return CCS to the “C/C++ Perspective” view.

28. Next, close the project by right-clicking on Lab2 in the C/C++ Projects window
and select Close Project.

End of Exercise

Note: By default, the watchdog timer is enabled out of reset. Code in the file
CodeStartBranch.asm has been configured to disable the watchdog. This can be
important for large C code projects (ask your instructor if this has not already been
explained). During this lab exercise, the watchdog was actually re-enabled (or disabled
again) in the file Watchdog. c.
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Control Peripherals

Control Peripherals

ADC Module
ADCINAO — ™
ADCINAL=Imux|__[SH RESULTO
H A A
-  RESULT1 |
ADCINA7 — x 12-bit A/D
g c RESULT2
ADCINGO — onverter 5
ADCINB1 =" pvuUX S/H
: = 5 Soc RESULTI5
ADCINB7 —_¢~
ADC ADC K
ADC full-scale T CHSEL Generation [FEO&X Interrupt ADCINTL-9,
input range is Logic Logic
0to 3.3V
SOCx Signal ADCINT1
ADCINT2
SOCO |TRIGSEL |CHSEL |[ACQPS | ,
SOC1 |TRIGSEL [CHSEL [ACQPS | ©
SOC2 |TRIGSEL |CHSEL | ACQPS 8 Software
SOC3 |TRIGSEL [CHSEL [ACQPS | = CPU Timer (0,1,2)
: . s |5 EPWMxSOCA (x=1t07)
. : ¢ o EPWMxSOCB (x=11t07)
SOC15 |TRIGSEL |CHSEL |ACQPS % External Pin
SOCx Configuration Registers (GPIO/XINT2_ADCSOC)

Example — ADC Triggering aof2)

| Sample A2 B3 2 A7 when ePWM1 SOCB is generated and then generate ADCINT1n: |

SOCB (ETPWM1)

SOCo

Channel
A2

SOC1

Channel

SOC2

B3

Channel
A7

P oyiies | —{ Resulo_j—ro!
7 cycles Result0 no interrupt
1%%98'35 Resultl nointerrupt
Seyais | Fesu?

8cycles Result2 ADCINTLn

As above, but also sample A0 2> B0 = A5 continuously and generate ADCINT2n:

ADCINT2n

SOCB (ETPWM1)

Software Trigger

Result0 no interrupt

Resultl no interrupt

Result2 ADCINT1n

Result3 no interrupt

Result4 no interrupt

SOCO,| Channel Sample
A2 7 cycles
SOC1 | Channel Sample
B3 10 cycles
SOC2 | Channel Sample
A7 8 cycles
SOC3,| Channel Sample
A0 10 cycles
SOC4 | Channel Sample
BO 15 cycles
SOCS5 | Channel Sample
A5 12 cycles

Results ADCINT2n
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Example — ADC Triggering of2)

| Sample all channels continuously and provide Ping-Pong interrupts to CPU/system: |

Software Trigger soco [Channel Sample Resulto _
ADCINT2n j) A0:BO 7 cycles Resultl no interrupt
SOC2 | Channel Sample Result2 .
Al:B1 7cycles Result3 no interrupt
SOC4 | Channel Sample Result4 )
A2:B2 7 cycles Results no interrupt
SOC6 | Channel | Sample Result6 .
A3:B3 7 cycles Result? ADCINT1n
SOC8 | Channel Sample Result8 )
A4:B4 7 cycles Resulto no interrupt
SOC10 | Channel Sample Result10 .
A5:B5 7 cycles Resultil no interrupt
SOC12 | Channel Sample Result12 :
A6:B6 7 cycles Resulti3 no interrupt
SOC14| Channel Sample Result14
AT.B7 7 cycles Result1s ADCINT2n
A0 &
BO @
Ale
Ble
A2 d
¢ — AIO2 | |10-bit COMP10UT,
—AIO10| | DAC
B2
* .
A3 e
B3 e
ADC

AlO4 | | 10-bit COMP20UT
AlO12| | DAC

—AIO6 | |10-bit COMP30UT
—Al014| | DAC

i

Comparator 3 available only on TMS320F2803x devices
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ADC Control Registers ile: adc.c)

¢ ADCTRL1 (ADC Control Register 1)
+ module reset, ADC enable
« busy/busy channel
+ reference select
« Interrupt generation control
¢ ADCSOCxCTL (SOCO0to SOC15 Control Registers)
« trigger source
+ channel
« acquisition sampling window
¢ ADCINTSOCSELx (Interrupt SOC Selection 1 and 2 Registers)
« selects ADCINTL1 / ADCINT2 trigger for SOCx
¢ ADCSAMPLEMODE (Sampling Mode Register)
+ sequential sampling / simultaneous sampling
¢ INTSELxNy (Interrupt x and y Selection Registers)
+« EOCO- EOC15 source select for ADCINT1-9
¢ ADCRESULTx  (ADC Result 0to 15 Registers)

Note: refer to the reference guide for a complete listing of registers

Pulse Width Modulation
What is Pulse Width Modulation?

¢ PWMis ascheme to represent a
signal as a sequence of pulses

+ fixed carrier frequency
+ fixed pulse amplitude

+ pulse width proportional to
Instantaneous signal amplitude

+ PWM energy ~ original signal energy

o ] T
Original Signal PWM representation
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Wh\S/ use PWM with Power
witching Devices?
¢ Desired output currents or voltages are known

¢ Power switching devices are transistors
« Difficult to control in proportional region
« Easy to control in saturated region

¢ PWMis adigital signal = easy for DSP to output

DC Supply DC Supply
) LI
" . PWM
D_esmla? PWM approx.
signalto of desired
/\/\’/ system ”.I-I_I_I_I-I.H_I-Iﬂ signal
Unknown Gate Signal Gate Signal Known with PWM

ePWM

ePWM Module Signals and Connections

_/—’_M
ePWMx-1
EPWMxSYNCI | EPWMXTZINT
GPIO | 71721-723
MUX EPWMXINT PIE
coepy EQEPIERR —TZ4 EPWMXA
GPIO
sysorr, CLOCKFAIL - T75 ePWMx EPWMXB MUY
cpyy EMUSTOP - 176
EPWMxSOCA
CoMPp |—SoMPXOUT EPWMxSOCB | ADC
EPWMxSYNCO
ePWMx+1
]

46
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ePWM Block Diagram

Shadowed
Clock Compare Compare
Prescaler Register Register
Tiriz-gletlse Compare Action Dead
) Logic ualifier Band
TBCLK EoliTEr g Q —‘
EPWMxXSYNCI EPWMxXSYNCO .
Period
................. Register L - EPWMxA
e —— PWM Trip
i Chopper Z0Ne ——
SYSCLKOUT EPWMxB
I_t TZy
Digital e 721723
Compare [&#—— COMPXOUT

ePWM Time-Base Sub-Module

Shadowed
Clock Com pareJ J
= |Prescaler Register Register
: Ti;izggse »| Compare Action Dead
E TBCLK Counter Logic Qualifier Band
T4+ 9 —‘
u EPWMxSYNCI EPWMxSYNCO
H Period
:lllllll: Register L - EPWMxA
H PWM Trip
E Chopper Z0Ne ——
SYSCLKOUT EPWMxB
I_t TZy
Digital e 721723
Compare [¢#—— COMPXOUT

C2000 Piccolo 1-Day Workshop
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ePWM Time-Base Count Modes

TBCTR

TBPRD

Asymmetrical
Waveform

TBCTR

TBPRD

Count Up Mode

Asymmetrical
Waveform

TBCTR

TBPRD 1.

Count Down Mode

Symmetrical
Waveform

Count Up and Down Mode

ePWM Phase Synchronization

Ext. Syncin
(optional)
Phase En Syncin
b |[EPWMIA : -
R s :
CTR=zero !
CTR=CMPB:§\0_ EPWM1B
X—0
SyncOut H
To eCAP1 ! !
Syncin H 1
Phase gn  Syncin ;
$=120° j&—0—"0 + |[EPWM2A :
Q
CTR=zero—o
CTR=CMPB—0 © EPWM2B
X=—0 ¥
SyncOut !
Syncin i
Phase En Yy ! g=120° |
$=240°j[«—0"0 * |EPWM3A o E—
] \ \
CTR=zero=—o :
CTR=CcMPB—0 O EPWM3B !
X—0 — | :
SyncOut e ¢=240°—»

48
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ePWM Compare Sub-Module

Clock Compare
Prescaler Register
Tiri?e-glettse Compare == Action Dead
TBCLK Counter Logic |[emappiQualifier Band _‘
EPWMxXSYNCI EPWMxXSYNCO N
Period
Register L - EPWMxA
ST PWM Trip
i Chopper Zone f——
SYSCLKOUT EPWMxB
I_t TZy

Digital (e 721123
Compare [&#—— COMPXOUT

ePWM Compare Event Waveforms

TBCTR 4 | e = compare events are fed to the Action Qualifier Sub-Module |

TBPRD megmamt

CMPA Rkl el Asymmetrical
CMPB F--—-=----- | e ] - Waveform
TBCTR

TBCTR 4

TBPRD |

CMPA 1 Symmetrical
CMPB Waveform

Count Up and Down Mode
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ePWM Action Qualifier Sub-Module

[ Shadowed Shadowed
Clock Compare Compare
Prescaler Register Register
Tiri?e-glettse Compare Action [e=—p Dead
) Logic —] Qualifier Band
TBCLK | counter g Q — —‘
EPWMxXSYNCI EPWMxXSYNCO

Period
................ s Reg ister L - EPWMxA
i PWM Trip
H Shadowed

i Chopper Z0Ne ——
SYSCLKOUT EPWMxB
|—t TZy

Digital (e 721123
Compare [&#—— COMPXOUT

ePWM Action Qualifier Actions
for EPWMA and EPWMB

SW Time-Base Counter equals: EPWM
Force Ouf[put
Zero CMPA CMPB TBPRD Actions
S)\(N )Z( C)'(A‘ CXB )Fz Do Nothing
SlN f Cf‘ Cf’ E Clear Low
S,\rN % C,f‘ CTB ? Set High
SW Z CA CB P
T T T T T Toggle
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ePWM Count Up Asymmetric Waveform
with Independent Modulation on EPWMA / B

TBCTR

TBPRD f---------

8 B E

z|[P] [cB] [cA] [z][P
LX) [X \ X
EPWMA E §
z|[P]| [ce] [cA] [z]|P] [cB] [cAl [z][P
X)L X x| L X TLX
EPWMB

ePWM Count Up Asymmetric Waveform

with Independent Mddulation on EPWMA
TBCTR

TBPRD

EPWMA | i |
1 i I
z z
T T T
EPWMBl |
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ePWM Count Up-Down Symmetric

Waveform
with Independent Modulation on EPWMA /B

TBCTR

TBPRD

T 4 T \
EPWMA | ;
— i —
i cs| [cB cs| [cB
i) J T !
EPWWMB |

ePWM Count Up-Down Symmetric

Waveform
with Independent Modulation on EPWMA

TBCTR

TBPRD

) l R )
EPWMA |
!—
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ePWM Dead-Band Sub-Module

Shadowed Shadowed
. Clock Compare Compare
Prescaler Register Register
AL Compare Action —1 Dead
TBCLK Ul Logic Qualifier Band fum
Counter
EPWMxXSYNCI EPWMxXSYNCO .
Period
................ s Register L - EPWMxA
; Shaioied PWM Trip
Chopper Zone —
SYSCLKOUT EPWMxB
I_t TZy

Digital (e 721123
Compare [&#—— COMPXOUT

Motivation for Dead-Band

supply rail
gate signals are to power
complementary PWM switching
I—IU device

¢ Transistor gates turn on faster than they shut off
¢ Short circuit if both gates are on at same time!

C2000 Piccolo 1-Day Workshop 53



Control Peripherals

ePWM PWM Chopper Sub-Module

Shadowed Shadowed
Clock Compare Compare
Prescaler Register Register
Tiriz-gletlse Compare Action Dead
) Logic ualifier Band
TBCLK EoliTEr g Q —‘
EPWMxXSYNCI EPWMxXSYNCO .
Period
................ s Register L o m— EPWMxA
i —) ———
i Shadowed rp
i Chopper » Zone ——>
SYSCLKOUT EPWMxB
I_t TZy

Digital (e 721123
Compare [&#—— COMPXOUT

ePWM Chopper Waveform

¢ Allows a high frequency carrier signal to
modulate the PWM waveform generated by the
Action Qualifier and Dead-Band modules

¢ Used with pulse transformer-based gate drivers
to control power switching elements

EPWMXA |

CHPFREQ MHWWWHMHMMWMMU
EPWMxA , II-”_”-”-”-”-”-”- E :-I'I-u-”-u_l'm-m'l- :
EPWMxB ﬂ_l- _ : _I-I-I-I-II ‘ U
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ePWM Digital Compare Sub-Module

Digital

Shadowed
Clock Compare Compare
Prescaler Register Register
Tirr%?e-g:\se Compare Action Dead
) Logic ualifier Band
TBCLK Counter g Q —‘
EPWMxXSYNCI EPWMxSYNCO .
Period |
T Register L — - EPWMxA
rip
i [IEET T Chopper Z0Ne ——
SYSCLKOUT EPWMxB

TZy
J TZ1-TZ3

Compare == COMPXOUT

ﬁ DCAH

Digital Compare Sub-Module Signals

Time-Base Sub-Module

TZ1 _)

\w DCAL

TZ2

—_—

Digital Trip r—>| Generate PWM Sync [

Event A1

—

Event-Trigger Sub-Module

Compare

Generate SOCA |

Digital Trip

Trip-Zone Sub-Module

AF
]

Event A2

TZ3

—»

COMP10OUT
B
DCBH

Trip PWMA Output

Compare

I —

Generate Trip Interrupt

~

Time-Base Sub-Module

ks

_\w DCBL

COMP20OUT
—_—

COMP30UT
B

Generate PWM Sync

Digital Trip | >
Event B1

Event-Trigger Sub-Module

Compare

Generate SOCB

Trip-Zone Sub-Module

V3

Digital Trip
Event B2

Trip PWMB Output

L/

DCTRIPSEL

generate events w

Compare |

Generate Trip Interrupt )

”

TZDCSEL

DCACTL / DCBCTL ——---

The Digital Comﬁare sub-module compares signals external to the ePWM module to directly
ich are then fed to the Event-Trigger, Trip-Zone, and Time-Base sub-modules
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ePWM Trip-Zone Sub-Module

Shadowed
Clock Compare Compare
Prescaler Register Register
el Compare Action Dead
TBCLK UllineABiiss Logic Qualifier Band
Counter —‘
EPWMxSYNCI EPWMxSYNCO i
Period
................. Register L - EPWMxA
S PWM —] Trip >
i Chopper Z0NE [l
SYSCLKOUT EPWMxB
TZy
Digital JTZl-TZ3
Compare €= COMPXOUT

¢ Supports:

Over
Current
Sensors

Trip-Zone Features

¢ Trip-Zone has afast, clock independent logic path to high-impedance
the EPWMXxA/B output pins

¢ Interrupt latency may not protect hardware when responding to over
current conditions or short-circuits through ISR software

current conditions

eQEP1
SYSCTRL
CPU

CPU
= core
COMPXOUT Digia
Omﬁe EPWMXTZINT
TZ; Cycle-by-Cycle
TZ
M

TZ3 ode
Tz4 EQEPIERR
175 CLOCKFAIL One-Shot
TZ6 EMUSTOP Mode

EPWM1A
>

P
EPWM1B = W
—
M

[ ]
0
* u
o T
P
EPWMxA Y
— 7
EPWMxB = S
—

#1) one-shot trip for major short circuits or over

#2) cycle-by-cycle trip for current limiting operation
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ePWM Event-Trigger Sub-Module

—— |

Clock Compare Compare
Prescaler Register Register
Tirii-glettse .| Compare Action Dead
) "1 Logic ualifier Band
TBCLK ColinEr g Q
T A l t
EPWMxSYNCI EPWMxSYNCO N
Period
................. Register L — m— EPWMxA
rip
Shadowed
i [Shadowed’| Chopper Z0Ne p——
SYSCLKOUT EPWMxB
TZy
Digital Je! 122123
Compare j&—— COMPXOUT

TBCTR
TBPRD

ePWM Event-Trigger Interrupts and SOC

CMPB

CMPAT}

EPWMA

EPWMB

fr—
]

CTR = PRD |

CTR=01I

CTR=0o0r PRD

CTRU = CMPA

CTRD = CMPA |

CTRU = CMPB

CTRD = CMPB
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Hi-Resolution PWM (HRPWM)

. PWM Period o
Regular
Device Clock UL AU UL UUUUUUUTUUUUUIUTUTIULIn . P Step

i i.e. 16.67 ns

(e 60 MH2) IIIIIIIIIIIIIIII(I,JLJ___IIIIIIIIIIIIIIIII( )
HRPWM divides a clock ‘__,,..w"‘“"m.“ “«n Calibration Logic tracks the
cycle into smaller steps _m ______ m number of Micro Steps per

called Micro Steps > clock to account for

(Step Size ~= 150 ps) | Calibration Logic | variations caused by

Temp/Nolt/Process

| HRPWM
FIPEEEEETEREEETEFETT T gl Micro Step (<150 ps)

Significantly increases the resolution of conventionally derived digital PWM

Uses 8-bit extensions to Compare registers (CMPxHR), Period register
(TBPRDHR) and Phase register (TBPHSHR) for edge positioning control

Typically used when PWM resolution falls below ~9-10 bits which occurs at
frequencies greater than ~120 kHz (with system clock of 60 MHz)

Not all ePWM outputs support HRPWM feature (see device datasheet)

* oo

*

ePWM Control Registers ie: epwm.c)

¢ TBCTL (Time-Base Control)

« counter mode (up, down, up & down, stop); clock prescale; period
shadow load; phase enable/direction’; sync select

¢ CMPCTL (Compare Control)
+« compare load mode; operating mode (shadow /immediate)
¢ AQCTLA/B  (Action Qualifier Control Output A/B)
« action on up/down CTR = CMPA/B, PRD, 0 (nothing/set/clear/toggle)
¢ DBCTL (Dead-Band Control)
« infout-mode (disable / delay PWMxA/B); polarity select
¢ PCCTL (PWM-Chopper Control)
« enable/ disable; chopper CLK freq. & duty cycle; 1-shot pulse width
¢ DCTRIPSEL (Digital Compare Trip Select)
+ Digital compare A/B high/low input source select
& TZCTL  (Trip-Zone Control)
« enable/disable; action (force high /low / high-Z Inothing)
¢ ETSEL (Event-Trigger Selection)
« interrupt & SOCA/B enable / disable; interrupt & SOCA/B select

Note: refer to the reference guide for a complete listing of registers
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eCAP

Capture Module (eCAP)

()

Timer

Trigger

_ L
-

Y

Values

Timestamp

¢ The eCAP module timestamps transitions
on a capture input pin

pin

eCAP Module Block Diagram - capture Mode

CAP1POL

Polarity
Select 1

CAP2POL
Polarity
Select 2 PRESCALE
Event
CAP3POL Prescale | gcapy
Polarity |_| pin

Event Logic

_,| Capture 1
Register
N Capt'ure 2
Register
32-Bit
¥ Time-Stamp [
i Counter
Capture 3
............... —> .
Register
SYSCLKOUT
Capture 4
Register

Select 3

CAP4POL
Polarity

Select 4 [

C2000 Piccolo 1-Day Workshop

59



Control Peripherals

eCAP Module Block Diagram - apwm Mode
[ Shadowed Period
' _ Period Regeirsltc:ar Srr:%%%w
immediate | - Register (CAP3)
(CAP1)
32-Bit PWM
r=» Time-Stamp Compare ——>r—o-ua
Counter Logic ECAP
i pin
SYSCLKOUT
immediate Compare
Register |Compare
mode | (CAP2) | Register | Shadow
| Shadowed (CAP4)
eQEP
What is an Incremental Quadrature
Encoder?
A digital (angular) position sensor
photo sensors spaced 0/4 deg. apart
T slots spaced 0 deg. apart _9/4
= ‘

light source (LED P
T g ( ) :

N g —>! :
Ch. A | !
_ ch.B 5
shaft rotation
Incremental Optical Encoder Quadrature Output from Photo Sensors

Note: eQEP available only on the TMS320F2803x devices
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(00) (11) Increment

m——————

I
|
[
i
|
Ch. A |
|
[
I
|
[
1

Ch.B

1

1

]
A\

il

How is Position Determined from
Quadrature Signals?

Position resolution is 6/4 degrees

= counter @
AB= " 1ao oy (1)
| 1
lllegal
, _____ Transitions;
enerate
pﬁase error

interrupt
1

----- X0

Quadrature Decoder
State Machine

decrement
counter

eQEP Module Connections

Quadrature ch B
> Capture < \
EQEPXAXCLK
32-Bit Unit |_|
E-b Time-Base o || ouadrawre EQEPXB/XDIR -
: D d naex
LI Watchdog Se0ess EQEPxI
. EQEPXS Strobe )
from homing sensor
SYSCLKOUT
Position/Counter
=> " Compare [€
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Lab 3: Control Peripherals

» Objective

The objective of this lab is to demonstrate and become familiar with the operation of the on-chip
analog-to-digital converter and ePWM. ePWM1A will be setup to generate a 2 kHz, 25% duty
cycle symmetric PWM waveform. The waveform will then be sampled with the on-chip analog-
to-digital converter and displayed using the graphing feature of Code Composer Studio. The
ADC has been setup to sample a single input channel at a 50 kHz sampling rate and store the
conversion result in a buffer in the MCU memory. This buffer operates in a circular fashion, such
that new conversion data continuously overwrites older results in the buffer.

Two ePWM modules have been configured for this lab exercise:

ePWM1A — PWM Generation

e Used to generate a 2 kHz, 25% duty cycle symmetric PWM waveform

ePWM2 — ADC Conversion Trigger

e Used as a timebase for triggering ADC samples (period match trigger SOCA)

Lab 3: Control Peripherals

ePWM1 dat
TB Counter CPU copies ata
Compare connector ADC result to memory
Action Qualifier e RESULTO buffer during
ADC ISR

*— —_—

ADC-

INAO

—

View ADC
buffer PWM
ePWM2 triggering Samples

ADC on period match
using SOCA trigger every
20 ps (50 kHz) ePWM2 Code Composer

pointer rewind

Studio

The software in this exercise configures the ePWM modules and the ADC. It is entirely interrupt
driven. The ADC end-of-conversion interrupt will be used to prompt the CPU to copy the results
of the ADC conversion into a results buffer in memory. This buffer pointer will be managed in a
circular fashion, such that new conversion results will continuously overwrite older conversion
results in the buffer. The ADC interrupt service routine (ISR) will also toggle LED LD2 on the
Piccolo™ controlSTICK as a visual indication that the ISR is running.
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Notes

ePWMI1A is used to generate a 2 kHz PWM waveform

Program performs conversion on ADC channel A0 (ADCINAQO pin)

ADC conversion is set at a 50 kHz sampling rate

ePWM2 is triggering the ADC on period match using SOCA trigger

Data is continuously stored in a circular buffer

Data is displayed using the graphing feature of Code Composer Studio

ADC ISR will also toggle the LED LD2 as a visual indication that it is running

> Procedure

Open the Project

1. A project named Lab3 has been created for this lab. Open the project by clicking on
Project > Import Existing CCS/CCE Eclipse Project. The “Import”
window will open then click Browse... next to the “Select root directory” box. Navigate
to: C:\C28x\Labs\Lab3\Project and click OK. Then click Finish to import the
project.

2. Inthe C/C++ Projects window, click the plus sign (+) to the left of Lab3 to view
the project files. All Build Options have been configured for this lab. The files used in
this lab are:

Adc.c Gpio.c
CodeStartBranch.asm Lab 2 3.cmd
Defaultlsr_3 4.c Main_3.c
DelayUs.asm PieCtrl.c
DSP2802x_GlobalVvariableDefs.c PieVect.c
DSP2802x_Headers_nonBI0S.cmd SysCtrl.c
EPwm.c Watchdog.c

Setup of Shared I/O, General-Purpose Timerl and Comparel

Note: DO NOT make any changesto Gpio.c and EPwm.c — ONLY INSPECT

3. Open and inspect Gpio.c by double clicking on the filename in the project window.
Notice that the shared 1/O pin in GPIOO0 has been set for the ePWM1A function. Next,
open and inspect EPwm.c and see that the ePWM1 has been setup to implement the
PWM waveform as described in the objective for this lab. Notice the values used in the
following registers: TBCTL (set clock prescales to divide-by-1, no software force, sync
and phase disabled), TBPRD, CMPA, CMPCTL (load on 0 or PRD), and AQCTLA (set
on up count and clear on down count for output A). Software force, deadband, PWM
chopper and trip action has been disabled. (Note that the last steps enable the timer count
mode and enable the clock to the ePWM module). See the global variable names and
values that have been set using #define in the beginning of the Lab . h file. Notice that
ePWM2 has been initialized earlier in the code for the ADC. Close the inspected files.
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Build and Load

4, Click the “Bui Id” button and watch the tools run in the Console window. Check for
errors in the Problems window.

5. Click the “Debug” button (green bug). The “Debug Perspective” view should open, the
program load automatically, and you should now be at the start of Main(). If the device
has been power cycled since the last lab exercise, be sure to configure the boot mode to
EMU_BOOT_SARAM using the Scripts menu.

Run the Code — PWM Waveform

6. Open a memory window to view some of the contents of the ADC results buffer. To
open a memory window click: View -> Memory on the menu bar. The address label
for the ADC results buffer is AdcBuf in the “Data” memory page.

Exercise care when connecting any wires, as the power to the controlSTICK is on, and
we do not want to damage the controlSTICK! Details of pin assignments can be found
on the last page of this lab exercise.

Note:

7. Using a connector wire provided, connect the PWM1A (pin # 17) to ADCINAO (pin # 3)
on the controlSTICK.

8. Run your code for a few seconds by using the Run button on the toolbar, or using
Target -> Run onthe menu bar. After a few seconds halt your code by using the
Hal t button on the toolbar, or by using Target - Halt. Verify that the ADC result
buffer contains the updated values.

9. Open and setup a graph to plot a 50-point window of the ADC results buffer.
Click: Tools > Graph > Single Time and set the following values:

Acquisition Buffer Size 50

10.

DSP Data Type

16-bit unsigned integer

Sampling Rate (Hz) 50000
Start Address AdcBuf
Display Data Size 50
Time Display Unit us

Select OK to save the graph options.

The graphical display should show the generated 2 kHz, 25% duty cycle symmetric
PWM waveform. The period of a 2 kHz signal is 500 ps. You can confirm this by
measuring the period of the waveform using the “measurement marker mode” graph
feature. Right-click on the graph and select Measurement Marker Mode. Move
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the mouse to the first measurement position and left-click. Again, right-click on the
graph and select Measurement Marker Mode. Move the mouse to the second
measurement position and left-click. The graph will automatically calculate the
difference between the two values taken over a complete waveform period. When done,
clear the measurement points by right-clicking on the graph and select Remove All
Measurement Marks.

Frequency Domain Graphing Feature of Code Composer Studio

11. Code Composer Studio also has the ability to make frequency domain plots. It does this
by using the PC to perform a Fast Fourier Transform (FFT) of the DSP data. Let's make
a frequency domain plot of the contents in the ADC results buffer (i.e. the PWM
waveform).

Click: Tools > Graph -> FFT Magnitude and set the following values:

Acquisition Buffer Size 50

DSP Data Type 16-bit unsigned integer
Sampling Rate (Hz) 50000

Start Address AdcBuf

Data Plot Style Bar

FFT Order 10

Select OK to save the graph options.

12. On the plot window, hold the mouse left-click key and move the marker line to observe
the frequencies of the different magnitude peaks. Do the peaks occur at the expected
frequencies?

Using Real-time Emulation

Real-time emulation is a special emulation feature that allows the windows within Code
Composer Studio to be updated at up to a 10 Hz rate while the MCU is running. This not
only allows graphs and watch windows to update, but also allows the user to change values in
watch or memory windows, and have those changes affect the MCU behavior. This is very
useful when tuning control law parameters on-the-fly, for example.

13. The memory and single time graph windows displaying AdcBuf should still be open. The
connector wire between PWM1A (pin # 17) and ADCINAO (pin # 3) should still be
connected. In real-time mode, we will have our window continuously refresh at the
default rate. To view the refresh rate click:

Window - Preferences..
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and in the section on the left select the “CCS” category. Click the plus sign (+) to the left
of “CCS” and select “Debug”. In the section on the right notice the default setting:

e “Continuous refresh interval (milliseconds)” = 1000
Click OK.

Note: Increasing the “Continuous refresh interval” causes all enabled continuous refresh
windows to refresh at a faster rate. This can be problematic when a large number of
windows are enabled, as bandwidth over the emulation link is limited. Updating too
many windows can cause the refresh frequency to bog down. In this case you can just
selectively enable continuous refresh for the individual windows of interest.

14. Next we need to enable the graph window for continuous refresh. In the upper right-hand
corner of the graph window, left-click on the yellow icon with the arrows rotating in a
circle over a pause sign. Note when you hover your mouse over the icon, it will show
“Enable Continuous Refresh”. This will allow the graph to continuously
refresh in real-time while the program is running.

15. Enable the memory window for continuous refresh using the same procedure as the
previous step.

16. Run the code and watch the windows update in real-time mode. Click:

Scripts 2> Realtime Emulation Control - Run_Realtime with_Reset

17. Carefully remove and replace the connector wire from ADCINAO (pin # 3). Are the
values updating as expected?

18. Fully halt the CPU in real-time mode. Click:

Scripts -> Realtime Emulation Control - Full_Halt

Terminate Debug Session and Close Project

19. Terminate the active debug session using the Terminate Al button. This will close
the debugger and return CCS to the “C/C++ Perspective” view.

20. Next, close the project by right-clicking on Lab2 in the C/C++ Projects window
and select Close Project.

Optional Exercise

You might want to experiment with this code by changing some of the values or just modify the
code. Try generating another waveform of a different frequency and duty cycle. Also, try to
generate complementary pair PWM outputs. Next, try to generate additional simultaneous
waveforms by using other ePWM modules. Hint: don’t forget to setup the proper shared 1/O pins,
etc. (This optional exercise requires some further working knowledge of the ePWM.
Additionally, it may require more time than is allocated for this lab. Therefore, you may want to
try this after the class).

End of Exercise
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Lab Reference: Piccolo™ controlSTICK Header Pin Diagram

1 2 3 4
ADC-A7 ADC-A2 ADC-A0 3V3
COMP1 (+VE) Vref-HI
5 6 I 8
ADC-A4 ADC-B1 EPWM-4B TZ1
COMP?2 (+VE) GP10-07 GPI0-12
9 10 11 12
SCL ADC-B6 EPWM-4A ADC-A1
GPI10-33 GP10-06
13 14 15 16
SDA ADC-B7 EPWM-3B 5\V0
GPI10-32 GP10-05
17 18 19 20
EPWM-1A ADC-B4 EPWM-3A SPISOMI
GP10-00 COMP2 (-VE) GP10-04 GPI0-17
21 22 23 24
EPWM-1B ADC-B3 EPWM-2B SPISIMO
GP10-01 GP10-03 GPIO-16
25 26 27 28
SPISTE ADC-B2 EPWM-2A GND
GPIO-19 COMP1 (-VE) GP10-02
29 30 31 32
SPICLK GP10-34 PWM1A-DAC GND
GP10-18 (LED) (Filtered)
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Flash Programming

Flash Programming Basics

Flash Programming Basics

¢ The DSP CPU itself performs the flash programming

¢ The CPU executes Flash utility code from RAM that reads the
Flash data and writes it into the Flash

¢ Weneed to get the Flash utility code and the Flash data into RAM

FLASH |@¢— Ccpy
----->|Emulator |--> JTAG |— -------- >
RAM
------ >|R5232|—-> scl F--» )
1
———————————— > SPI F--» & '
sl
———————————— > 2C r--> & 3
o
m
———————————— > GPIO (=== >
TMS320F2802x

Flash Programming Basics

¢ Sequence of steps for Flash programming:

Algorithm Function
1. Erase - Set all bits to zero, then to one
2. Program - Program selected bits with zero
3. Verify - Verify flash contents

¢ Minimum Erase size is a sector (4Kw or 8Kw)
Minimum Program size is a bit!

* Im(?ortant not to lose power durinﬂ erase step:
If CSM passwords hap{aen to be all zeros, the
CSM will be permanently locked!

¢ Chance of this happeningois guite small! (Erase
step is performed sector by sector)

*
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Programming Utilities and CCS Flash Programmer

Flash Programming Utilities

¢ JTAG Emulator Based
+ Code Composer Studio on-chip Flash programmer
« BlackHawk Flash utilities (requires Blackhawk emulator)
« Elprotronic FlashPro2000
« Spectrum Digital SDFlash JTAG (requires SD emulator)
« Signum System Flash utilities (requires Signum emulator)
& SCI Serial Port Bootloader Based
+ Code-Skin (http://www.code-skin.com)
« Elprotronic FlashPro2000
¢ Production Test/Programming Equipment Based
+« BP Micro programmer
+ Data I/O programmer
¢ Build your own custom utility
+ Can use any of the ROM bootloader methods
« Can embed flash programming into your application
+ Flash APl algorithms provided by TI

* Tl web has links to all utilities (http:/Avww.ti.com/c2000)

CCS On-Chip Flash Programmer

¢ On-Chip Flash programmer is integrated into the CCS debugger

FE Cn-Chip Flash X

= T y . : - -
Ly fiter bot | On-Chip Flash (TMS320028XX) (3) Dpe fiter text | Kev 6 (0XAEG): | FFFF
an-chip Flash on-Chip Flash & ;
. 5 (0AES): | FFFF
Generic Debugger Options Clock Configuration Generic Debugger Options =
GEL Files I GEL Files Key 4 (OxAE4): | FFFF
asCCLk (mha): | 10 ] :
C28xx Debugger Options - C28xx Debugger Options e .
T 5 (0AE3): | FFFF
Memary Map CLEINDY: 2 Memory Map

PLLCR Yalue: | 12 Key 2 (0xAEZ): | FFFF

Key 1 (DxAE1): | FFFF
Flash Program Setting: —
(%) Erase, Program, Yerify

O Program, verify Program Password

() Load R Only
Frequency Test
Eras Sector Selsction

[#] Sector A: (0:x3F6000 - 0x3FTFFF) g -
[#] Sector B: (Ox3F4000 - Dx3FEFFF) Pin: | GPIOXD v |
[#] sector C: (0x3F2000 - Ox3F3FFF)
[] Sector D: (0x3F0000 - Dx3F1FFF)
[] Sector E: {0x3EE00D - 0x3EFFFF) Depatin Recowery

[¥] sector F: (0x3EC000 - OX3EDFFF) -

[¥] Sector G: (0x3EADOD - 0x3EBFFF)

Register! | GPAMUz1 |

[start Frequency Test | [End Frequency Test

[¥] Sector H: (0x3E000 - Ox3EIFFF) Checksum
Erase Flash Flash Checksum:

OTF Checksum:
Code Security Password

Key 7 (O=RE7): | FFFF | Calculate Checksum
Key 6 (0xAEG): | FFFF |

:
Fey 5 (0AES): FFFF | v v
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Code Security Module and Password

Code Security Module (CSM)

¢ Access to the following on-chip memory is restricted:

0x000A80

0x008000
0x009000
0x3D7800
0x3D7C00
0x3D7C80
0x3D8000
0x3F0000
Ox3F7FF8
0x3F8000
0x3F9000

Flash Registers

L0 SARAM (4Kw)

reserved

User OTP (1Kw)

reserved

ADC / OSC cal. data

reserved

FLASH (32Kw)

PASSWORDS (8w)

L0 SARAM (4Kw)

Dual
Mapped

¢ Datareads and writes from restricted memory are only

allowed for code running from restricted memory

& All other data read/write accesses are blocked:

JTAG emulator/debugger, ROM bootloader, code running in
external memory or unrestricted internal memory

CSM Password

0x3F0000

Ox3F7FF8

the device

FLASH (32Kw) /{
128-Bit Password

CSM Password
Locations (PWL)
Ox3F7FF8 - Ox3F7FFF

¢ 128-bit user defined password is stored in Flash

¢ 128-bit KEY registers are used to lock and unlock

+ Mapped in memory space 0x00 OAEO — 0x00 OAE7

+ Registers “EALLOW” protected

70

C2000 Piccolo 1-Day Workshop




Flash Programming

CSM Password Match Flow

Start Is PWL =>_Yes .
Al 05?2 Device permanently locked
No
Flash de\gce
secure after
reset or runtime Is PWL = Yes
all Fs?
No
%) GLIT U=l B AL Write password to KEY registers|
Ox3F 7FF8 — Ox3F 7FFF | 0X00 DAEO — 0x00 0AE7
EE—— (EALLOW) protected

Device unlocked

User can access on-
chip secure memory
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Lab 4. Programming the Flash
» Objective

The objective of this lab is to program and execute code from the on-chip flash memory. The
TMS320F28027 device has been designed for standalone operation in an embedded system.
Using the on-chip flash eliminates the need for external non-volatile memory or a host processor
from which to bootload. In this lab, the steps required to properly configure the software for
execution from internal flash memory will be covered.

Lab 4. Programming the Flash
ePWM1 ADC mggtgry
TB Counter ADCINAO | RESULTO
Compare 2
Action Qualifier CPU copies s
connector L) resultto o
wire i buffer during =
ADC ISR - o
: . £
ePWM2 triggering @ " 3
ADC on period match
using SOCA trigger every E
20 ps (50 kkiz) ePWM2 View ADC
@ buffer PWM
Samples
Obiective: Code Corr_1 poser
Studio
¢ Program system into Flash Memory
¢ Learn use of CCS Flash Programmer
¢ DO NOT PROGRAM PASSWORDS

» Procedure

Open the Project

1. A project named Lab4 has been created for this lab. Open the project by clicking on
Project - Import Existing CCS/CCE Eclipse Project. The “Import”
window will open then click Browse... next to the “Select root directory” box. Navigate
to: C:\C28x\Labs\Lab4\Project and click OK. Then click Finish to import the
project.

2. Inthe C/C++ Projects window, click the plus sign (+) to the left of Lab4 to view
the project files. All Build Options have been configured for this lab. The files used in
this lab are:
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Adc.c Gpio.c
CodeStartBranch.asm Lab_4.cmd
Defaultlsr_3 4.c Main_4.c
DelayUs.asm Passwords.asm
DSP2802x_GlobalVvariableDefs.c PieCtrl.c
DSP2802x_Headers_nonBI0S.cmd PieVect.c
EPwm.c SysCtrl.c
Flash.c Watchdog.c

Link Initialized Sections to Flash

Initialized sections, such as code and constants, must contain valid values at device power-up.
Stand-alone operation of an F28027 embedded system means that no emulator is available to
initialize the device RAM. Therefore, all initialized sections must be linked to the on-chip flash
memory.

Each initialized section actually has two addresses associated with it. First, it has a LOAD
address which is the address to which it gets loaded at load time (or at flash programming time).
Second, it has a RUN address which is the address from which the section is accessed at runtime.
The linker assigns both addresses to the section. Most initialized sections can have the same
LOAD and RUN address in the flash. However, some initialized sections need to be loaded to
flash, but then run from RAM. This is required, for example, if the contents of the section needs
to be modified at runtime by the code.

3. Open and inspect the linker command file Lab_4_.cmd. Notice that a memory block
named FLASH_ABCD has been been created at origin = 0x3F0000, length = 0x007F80
on Page 0. This flash memory block length has been selected to avoid conflicts with
other required flash memory spaces. See the reference slide at the end of this lab exercise
for further details showing the address origins and lengths of the various memory blocks
used.

4. InLab_4.cmd the following compiler sections have been linked to on-chip flash
memory block FLASH_ABCD:

Compiler Sections:

text .cinit .const .econst pinit .switch

Copying Interrupt Vectors from Flash to RAM

The interrupt vectors must be located in on-chip flash memory and at power-up needs to be
copied to the PIE RAM as part of the device initialization procedure. The code that performs this
copy is located in InitPieCtri (). The C-compiler runtime support library contains a
memory copy function called memcpy() which will be used to perform the copy.

5. Open and inspect InitPieCtrl() in PieCtrl .c. Notice the memcpy() function used to
initialize (copy) the PIE vectors. At the end of the file a structure is used to enable the
PIE.
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Initializing the Flash Control Registers

The initialization code for the flash control registers cannot execute from the flash memory (since
it is changing the flash configuration!). Therefore, the initialization function for the flash control
registers must be copied from flash (load address) to RAM (run address) at runtime. The memory
copy function memcpy() will again be used to perform the copy. The initialization code for the
flash control registers InitFlash() is located in the Flash. c file.

6. Open and inspect Flash_c. The C compiler CODE_SECTION pragma is used to place
the InitFlash() function into a linkable section named “secureRamFuncs”.

7. The “secureRamFuncs” section will be linked using the user linker command file
Lab_4.cmd. Openand inspect Lab_4.cmd. The “secureRamFuncs” will load to
flash (load address) but will run from LOSARAM (run address). Also notice that the
linker has been asked to generate symbols for the load start, load end, and run start
addresses.

While not a requirement from a MCU hardware or development tools perspective (since
the C28x MCU has a unified memory architecture), historical convention is to link code
to program memory space and data to data memory space. Therefore, notice that for the
LOSARAM memory we are linking “secureRamFuncs” to, we are specifiying “PAGE
= 0” (which is program memory).

8. Open and inspect Main_4._c. Notice that the memory copy function memcpy() is being
used to copy the section “secureRamFuncs”, which contains the initialization
function for the flash control registers.

9. The following line of code in main() is used call the InitFlash() function. Since
there are no passed parameters or return values the code is just:

InitFlash(Q);

at the desired spot inmain().

Code Security Module and Passwords

The CSM module provides protection against unwanted copying (i.e. pirating!) of your code from
flash, OTP memory, and the LOSARAM block. The CSM uses a 128-bit password made up of 8
individual 16-bit words. They are located in flash at addresses Ox3F7FF8 to Ox3F7FFF. During
this lab, dummy passwords of OxFFFF will be used — therefore only dummy reads of the
password locations are needed to unsecure the CSM. DO NOT PROGRAM ANY REAL
PASSWORDS INTO THE DEVICE. After development, real passwords are typically placed in
the password locations to protect your code. We will not be using real passwords in the
workshop.

The CSM module also requires programming values of 0x0000 into flash addresses 0x3F7F80
through 0x3F7FF5 in order to properly secure the CSM. Both tasks will be accomplished using a
simple assembly language file Passwords.asm.
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10. Open and inspect Passwords.asm. This file specifies the desired password values
(DO NOT CHANGE THE VALUES FROM 0xFFFF) and places them in an initialized
section named “passwords”. It also creates an initialized section named “csm_rsvd”
which contains all 0x0000 values for locations Ox3F7F80 to Ox3F7FF5 (length of 0x76).

11. Open Lab_4.cmd and notice that the initialized sections for “passwords” and
“csm_rsvd” are linked to memories named PASSWORDS and CSM_RSVD,
respectively.

Executing from Flash after Reset

The F28027 device contains a ROM bootloader that will transfer code execution to the flash after
reset. When the boot mode selection is set for “Jump to Flash” mode, the bootloader will branch
to the instruction located at address Ox3F7FF6 in the flash. An instruction that branches to the
beginning of your program needs to be placed at this address. Note that the CSM passwords
begin at address Ox3F7FF8. There are exactly two words available to hold this branch
instruction, and not coincidentally, a long branch instruction “LB” in assembly code occupies
exactly two words. Generally, the branch instruction will branch to the start of the C-
environment initialization routine located in the C-compiler runtime support library. The entry
symbol for this routine is _c_int00. Recall that C code cannot be executed until this setup routine
is run. Therefore, assembly code must be used for the branch. We are using the assembly code
file named CodeStartBranch.asm.

12. Open and inspect CodeStartBranch.asm. This file creates an initialized section
named “codestart” that contains a long branch to the C-environment setup routine.
This section has been linked to a block of memory named BEGIN_FLASH.

13. In the earlier lab exercises, the section “codestart” was directed to the memory
named BEGIN_MO. Open and inspect Lab_4.cmd and notice that the section
“codestart” will now be directed to BEGIN_FLASH. Close the inspected files.

On power up the reset vector will be fetched and the ROM bootloader will begin execution. If
the emulator is connected, the device will be in emulator boot mode and will use the EMU_KEY
and EMU_BMODE values in the PIE RAM to determine the bootmode. This mode was utilized
in an earlier lab. In this lab, we will be disconnecting the emulator and running in stand-alone
boot mode (but do not disconnect the emulator yet!). The bootloader will read the OTP_KEY
and OTP_BMODE values from their locations in the OTP. The behavior when these values have
not been programmed (i.e., both OXFFFF) or have been set to invalid values is boot to flash
bootmode.

Build — Lab.out
14. Click the “Bui 1d” button to generate the Lab . out file to be used with the CCS Flash
Programmer. Check for errors in the Problems window.

CCS Flash Plug-in

In CCS (version 4.x) the on-chip flash programmer is integrated into the debugger. When the
program is loaded CCS will automatically determine which sections reside in flash memory based
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on the linker command file. CCS will then program these sections into the on-chip flash memory.
Additionally, in order to effectively debug with CCS, the symbolic debug information (e.qg.,
symbol and label addresses, source file links, etc.) will automatically load so that CCS knows
where everything is in your code.

Clicking the “Debug” button in the C/C++ Perspective will automatically launch the
debugger, connect to the target, and program the flash memory in a single step.

15.

16.

17.

Program the flash memory by clicking the “Debug” button (green bug). (If needed,
when the “Progress Information” box opens select “Detai ls >>" in order to watch
the programming operation and status). After successfully programming the flash
memory the “Progress Information” box will close.

Flash programming options are configured with the “On-Chip Flash” control panel.
Open the control panel by clicking:

Tools - On-Chip Flash

Scroll the control panel and notice the various options that can be selected. You will see
that specific actions such as “Erase Flash” can be performed.

The CCS on-chip flash programmer was automatically configured to use the Piccolo™
10 MHz internal oscillator as the device clock during programming. Notice the “Clock
Configuration” settings has the OSCCLK set to 10 MHz, the DIVSEL set to /2, and the
PLLCR value set to 12. Recall that the PLL is divided by two, which gives a
SYSCLKOUT of 60 MHz.

The flash programmer should be set for “Erase, Program, Verify” and all boxes in the
“Erase Sector Selection” should be checked. We want to erase all the flash sectors.

We will not be using the on-chip flash programmer to program the “Code Security
Password”. Do not modify the Code Security Password fields. They should remain as
all OXFFFF.

Close the “On-Chip Flash” control panel by clicking the X on the tab.

Running the Code — Using CCS

18.

19.

Reset the CPU using the “Reset CPU” button or click:
Target > Reset > Reset CPU

The program counter should now be at address 0Ox3FF7BB in the “Disassembly” window,
which is the start of the bootloader in the Boot ROM.

Under Scripts on the menu bar click:

EMU Boot Mode Select - EMU BOOT_FLASH.

This has the debugger load values into EMU_KEY and EMU_BMODE so that the
bootloader will jump to "FLASH" at address Ox3F7FF6.
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20. Single-Step by using the <F5> key (or you can use the Step Into button on the
horizontal toolbar) through the bootloader code until you arrive at the beginning of the
codestart section in the CodeStartBranch.asm file. (Be patient, it will take about
125 single-steps). Notice that we have placed some code in CodeStartBranch.asm
to give an option to first disable the watchdog, if selected.

21. Step a few more times until you reach the start of the C-compiler initialization routine at
the symbol _c_int0O0.

22. Now do Target > Go Main. The code should stop at the beginning of your
main()routine. If you got to that point succesfully, it confirms that the flash has been
programmed properly, that the bootloader is properly configured for jump to flash mode,
and that the codestart section has been linked to the proper address.

23. You can now RUN the CPU, and you should observe the LED on the controlSTICK
blinking. Try resetting the CPU, select the EMU_BOOT_FLASH boot mode, and then
hitting RUN (without doing all the stepping and the Go Main procedure). The LED
should be blinking again.

24. HALT the CPU.

Terminate Debug Session and Close Project

25. Terminate the active debug session using the Terminate Al button. This will close
the debugger and return CCS to the “C/C++ Perspective” view.

26. Next, close the project by right-clicking on Lab4 in the C/C++ Projects window
and select Close Project.

Running the Code — Stand-alone Operation (No Emulator)

27. Close Code Composer Studio.
28. Disconnect the controlSTICK from the computer USB port.
29. Re-connect the controlSTICK to the computer USB port.

30. The LED should be blinking, showing that the code is now running from flash memory.

End of Exercise
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Lab 4 Reference: Programming the Flash

Flash Memory Section Blocks
origin =
0x3F 0000
FLASH
length = Ox7F80
page =0 Lab_4.cmd
SECTIONS
{
OX3F7F&0|  cgM RSVD codestart :> BEGIN_FLASH, PAGE =0
length = 0x76 passwords :> PASSWORDS, PAGE=0
page =0 csm rsvd > CSM_RSVD, PAGE=0
Ox3F 7FF6| BEGIN_FLASH }
length = 0x2 \’_///’_
page=0
Ox3F 7FF8| PASSWORDS
length = Ox8
page =0

Startup Sequence from Flash Memory

-

OX3F 0000 | 1) o 3ok € int00} 52800 ml.lib”

— OX3F7FF6 | | LB
........ -£.Int00 ——— @) “User” code sections
Passwords (8w) main ()

® L

0x3F E000 | Boot ROM (8Kw) N\ }

Boot Code AN
Ox3F F7BB N

{SCAN GPIC} @ N
BROM vector (32w) \

5 0x3F FFCO 0x3F F7TBB ——

RESET
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The Next Step...

Training

F28x Multi-day Training Course

TMS320F2803x Workshop Outline

- Architectural Overview

- Programming Development Environment
- Peripheral Register Header Files

- Reset and Interrupts

- System Initialization

- Analog-to-Digital Converter

- Control Peripherals

- Numerical Concepts and IQmath

|n-depth hands-on - Control Law Accelerator (CLA)
TMS320F28035 Design |- System Design
and Peripheral - Communications
Training - DSP/BIOS

- Support Resources

controlSUITE

controlSUITE™
nls conl ralSUITE [ 1=]3]
- {* contoiSUITE Lt Mﬁ
™
8 ‘ s contrelSUITE
2 }” i Coamprehensive. Intuitive, Optimized. Real world saftware for real time 1l
o [ R m _T#7  controlSUITE™ Software
7] &) vodse : 1 -« | Compmhenswe Intuitive. Optimized
c R oo o
e m Ullpumﬂﬂlﬂd access
m u Training and Support m » Download
ki
3 = Diatashents and Guides m
V¥ Code ComposerSuginiDE 1, s
&
St - @
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Development Tools

C2000 Ex

F28027,

TMDXDOCK28027

TMDXDOCK?28035

TMDSDOCK?2808

TMDSDOCK 28335

Pzerimenter’s Kits

8035, F2808, F28335

¢ Experimenter Kits include

+ F28027, F28035, F2808 or F28335
controlCARD

+ USB docking station

+ C2000 Applications Software CD
with example code and full
hardware details

+ Code Composer Studio v3.3 with
code size limit of 32KB

¢ Docking station features
+ Access to controlCARD signals
+ Breadboard areas
+ Onboard USB JTAG Emulation
« JTAG emulator not required

¢ Available through Tl authorized
distributors and the Tl eStore

C2834x Experimenter’s Kits
C28

TMDXDOCK28343

TMDXDOCK?28346-168

343, C28346

¢ Experimenter Kits include
« (C2834x controlCARD
« Docking station

« C2000 Applications Software CD
with example code and full
hardware details

+ Code Composer Studio v3.3 with
code size limit of 32KB

« 5V power supply

¢ Docking station features
« Access to controlCARD signals

+ Breadboard areas

« JTAG emulator required — sold
separately

¢ Availablethrough Tl authorized
distributors and the Tl eStore
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F28335 Peripheral Explorer Kit

& Experimenter Kit includes
« F28335 controlCARD
« Peripheral Explorer baseboard

« C2000 Applications Software CD
with example code and full
hardware details

g — +« Code Composer Studio v3.3 with
code size limit of 32KB

+« 5V DC power supply

¢ Peripheral Explorer features
« ADC input variable resistors
+ GPIO hex encoder & push buttons
+ eCAP infrared sensor
+ GPIO LEDs, I12C & CAN connection
+ Analog I/O (AIC+McBSP)

¢ JTAG emulator required — sold
separately

¢ Available through Tl authorized
distributors and the Tl eStore

"netrument.

eXas

TMDSPREX28335

Digital Power ¢ Kitsincludes

Experimenter's + controlCARD and application

specific baseboard
« Full version of Code Composer

Digital Power Studio v3.3 with 32KB code size
Deve}l(qtper’s limit
|
¢ Software download includes
RQD%’/B%M + Complete schematics, BOM, gerber
Developer’s Kit files, and source code for board
and all software
ReE“ewame + Quickstart demonstration GUI for
Developer's Kit quick and easy access to all board
features
AC/DC + Fully documented software
Developer's specific to each kit and application
Kit .
¢ See www.ti.com/c2000 for more
Dual Motor details
Control and . .
DG s ¢ Available through Tl authorized
ar distributors and the TI eStore

C2000 Piccolo 1-Day Workshop

81



The Next Step...

C2000 Signal Processing Libraries

C2000 Signal Processing Libraries
Signal Processing Libraries & Applications Software Literature #
ACI3-1: Control with Constant V/Hz SPRC1%
ACI3-3: Sensored Indirect Flux Vector Control SPRC207
ACI3-3: Sensored Indirect Flux Vector Control (simulation) SPRC208
ACI3-4: Sensorless Direct Flux Vector Control SPRC195
ACI3-4: Sensorless Direct Flux Vector Control (simulation) SPRC209
PMSM3-1: Sensored Field Oriented Control using QEP SPRC210
PMSM3-2: Sensorless Field Oriented Control SPRC197
PMSM3-3: Sensored Field Oriented Control using Resolver SPRC211
PMSM3-4: Sensored Position Control using QEP SPRC212
BLDC3-1: Sensored Trapezoidal Control using Hall Sensors SPRC213
BLDC3-2: Sensorless Trapezoidal Drive SPRC196
DCMOTOR: Speed & Position Control using QEP without Index SPRC214
Digital Motor Control Library (F/C280x) SPRC215
Communications Driver Library SPRC183
DSP Fast Fourier Transform (FFT) Library SPRC081
DSP Filter Library SPRC082
DSP Fixed-Point Math Library SPRC085
DSP IQ Math Library SPRCO087
DSP Signal Generator Library SPRC083
DSP Software Test Bench (STB) Library SPRC084
C28x FPU Fast RTS Library SPRC664
DSP2802x C/C++ Header Files and Peripheral Examples SPRC832
Available from Tl Website = http://www.ti.com/c2000

C2000 Worksh

op Download Wiki

J@ TeExas
INSTRUMENTS

navigation

= Main Page

= Al pages

= All categories
= Popularpages
= Popularauthors
= Popular categories
= Category stats
= Recent changes
= Random page
= Help

= Google Search

printiesport
= Create a book

= Download as PDF
= Printable version

gearch
Search
ool

Whatlinks here
Related changes
Special pages
Parmaneant link
Printas POF

C2000 Workshop Download Wiki

& Login/create account
page discussion view Source histary

Hands-On Training for TI| Embedded Processors
(Redirected from Training)
Hands-On Training for T Embedded Processors

TI's Techrical Training Organization conducts hands-on training for Tl embedded processors at various worldwide locations.
You can find complete course descriptions, locations, dates, and enrallment information here é.

On the Tl training site, you can find specific workshop locations/dates using the left-hand navigation links. Select "By Type”
and then select either "1-Day Workshops" or "WMulti-Day Workeshops" to get 2 complete list of training available. Click on the
"Register Now" button, or one of the individual "Register” buttons to enrall in a workshop.

If you would like to review specific workshop materials on your own, you can download the files using the links below.
C2000™ 32-bit Real-time MCU Training

C2000™ Piccolo™ One-Day Workshop
C2000™ Piccolo™ MultiDay Warkshop agenda, locations, and schadule &9
Online materials and labs

C2000™ Piccolo™ Multi-Day Workshop
C2000™ Piccolo™ Multi-Day Waorkshop agenda, locations, and schedule &9
Online materials labs

C2000™ Delfino™ Multi-Day Workshop
TWS320C28:™ MCU Waorkshop agenda, locations, and schadule &9
Online materials and labs

C2000™ Archived Workshops

The archived warkshops are for F2407, F2812, and F2808 one-day and rmulti-day workshops. The F28335 eZdsp one-day
wotkshop is also found here C2000 archived workshops

http://processors.wiki.ti.com/index.php/Hands-On_Training_for_TI Embedded Processors
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Development Support

For More Information . . .

Internet
Website: http://www._ti._com

FAQ: http://www-k.ext.ti.com/sc/technical_support/knowledgebase.htm

+ Device information ¢ my.ti.com
+ Application notes + News and events
¢ Technical documentation ¢ Training

Enroll in Technical Training:  http:/www.ti.com/sc/training

USA - Product Information Center (PIC)
Phone: 800-477-8924 or 972-644-5580
Email: support@ti.com

¢ Information and support for all TI Semiconductor products/tools
+ Submit suggestions and errata for tools, silicon and documents

European Product Information Center (EPIC)

Web: http:/Mmvww-k.ext.ti.com/sc/technical support/pic/euro.htm

Phone: Language Number

Belgium (English) +32 (0) 27 45 55 32
France +33 (0) 1 30 70 11 64
Germany +49 (0) 8161 80 33 11
Israel (English) 1800 949 0107 (free phone)
Italy 800 79 11 37 (free phone)
Netherlands (English) +31 (0) 546 87 95 45
Spain +34 902 35 40 28
Sweden (English) +46 (0) 8587 555 22
United Kingdom +44 (0) 1604 66 33 99
Finland (English) +358(0) 9 25 17 39 48

Fax: All Languages +49 (0) 8161 80 2045

Email: epic@ti.com

¢ Literature, Sample Requests and Analog EVM Ordering

+ Information, Technical and Design support for all Catalog Tl
Semiconductor products/tools

+ Submit suggestions and errata for tools, silicon and documents
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